
Power Chords 1.1 Help Index
Getting Started:

Introduction to Power Chords
Installing and Configuring Power Chords
Running the Tutorial
Quick Start Guide
About Windows, MIDI, Drivers and the MIDI Mapper
MIDI Input Instruments and MIDI Thru
Power Chords Information

Commands:
File Menu
Options Menu
Palette Menu
Song Menu
Script Menu
Window Menu
Help Menu

Windows:

   Instrument                            

   Rhythm Editor                                    

   Song Window  

   Chord Palette                       

   Chord Rhythm Palette                      

   Melody Palette  

   Bass Part Palette                

   Drum Rhythm Palette                       

   Control Palette  

   Staff Window                        

   Tempo Window                                  

   Garbage Window  
help ver. 1.109



Introduction to Power Chords
Welcome to Power Chords. This introduction will give you a basic understanding of Power Chords 
concepts and will begin teaching you to use the program.

It is recommended that you:

1: Read this introduction first.
2: Configure Power Chords for your system.
3: Run the interactive tutorial. 

Upon completion of these three steps you should be able to use Power Chords to create music. More 
extensive information on Power Chords is available via the help facility. The most important rule of 
thumb is to experiment - try things! There are often many different ways to accomplish the same task. 
Find out what suits you best.

Power Chord Concepts

Song Structure:

A song is composed of one or more parts. The following parts are supported: Chords, Chord Rhythms 
(strumming, plucking, or fingering patterns to apply to the chords), Drum Parts, Melodies, and Bass 
Parts.

Each part is composed of small music elements that are repeated as needed. It is possible to use one 
music element the full length of the song for a part, but usually each part will contain shorter sections 
that are repeated. This means that the repeatable section only needs to be created once, and then re-
used in various places in the song. Variations of music elements are easy to create by modifying a copy
of the original music element.

Songwriting Technique:

Often, the first part of the song to be created is the chord structure. Each chord used in the song is 
created using the Instrument window and is stored in the Chord Palette. Only one copy of each chord 
is needed in the palette as the chord may be copied from the palette into the song to as many places as
it is needed. All the palettes in Power Chords function in this way. Once you have all the song's chords 
in the Chord Palette, they can be copied into the Song window to the appropriate locations.

Next Chord Rhythms are created. These are the patterns used to play the chords in the song and are 
equivalent to strumming or plucking patterns on a stringed instrument. The Rhythm Editor is used to 
create each repeatable Chord Rhythm. As each Chord Rhythm is completed it is stored in the Chord 
Rhythm Palette. Chord Rhythms are copied into the song to the appropriate locations.

If a Chord Rhythm is needed more than once in consecutive bars, it only has to be put into the first bar 
of that section. Power Chords automatically repeats Chord Rhythms until a new one is encountered. 
The actual notes played depend on the chord that is in each bar played.

For example, if a Chord Rhythm is to be repeated in bars 4 through 7 of a song, it only needs to be 
copied to bar 4. Power Chords will repeat it until it encounters a different Chord Rhythm in bar 8. If the 
Chord Rhythm in bar 4 is 3 bars long, it will be played fully once through (in bars 4, 5 and 6), and then 
the first bar of it will play in bar 7. Once the new Chord Rhythm in bar 8 is encountered, it will be played 
starting in bar 8 even though the previous Chord Rhythm was not fully repeated the second time 
through.



Drum Rhythms are created using the Rhythm Editor and stored in the Drum Rhythm Palette. From 
there they are positioned in the song in the appropriate bars. Like Chord Rhythms, Drum Rhythms 
automatically repeat until a different one is encountered.

Bass Parts and Melodies are created in the Rhythm Editor by using the mouse, by importing from a 
MIDI file, or by recording directly from a MIDI instrument. Once melodies are in the Melody Palette 
they may have one of many MIDI patches assigned to them. This applies to Bass Parts as well.

If one has special patch changes or other MIDI control data to be sent, Controls can be created in the 
control palette and then put into place in the song. Controls can be used to change patches in the 
middle of a melody for example, or to send setup information to an external MIDI sound module.

Songs are saved in Power Chords song files. The song itself and the contents of all the Palettes are 
saved. Instrument setup and drum kit information are also saved in the file. The song can also be saved
as a Standard Type 1 MIDI file for export to another music program.

Instrument Flexibility:

By using the tuning options, it is possible to simulate almost any type of stringed instrument (real or 
imaginary). It is also possible to play chords that would not be humanly playable if the instrument 
existed. Note that the Chord Request function works for any combination of string tunings you may 
devise.

Education:

You are encouraged to write and distribute Power Chords Script files. This is a powerful medium 
through which it is possible to create interactive lessons, tutorials, or even musical correspondence. 
Use of the Staff window can help you relate stringed instrument chords to their notated counterparts. 
And, when it comes to learning about Chord Progressions,    and their use in songs, Percussion 
Rhythms, arranging, etc., Power Chords is ideal.

The Philosophy of Power Chords:

Power Chords was designed to let you work with music using the skills that you already have. Power 
Chords provides tools that make it easy to do the things that you don't have the skills for.

The basic input 'metaphor' in Power Chords is that of a guitar or other stringed instrument. This area of 
musical skill has remained unexploited by software manufacturers until now. Guitarists will find 
themselves at home in the Power Chords environment. However, you do not have to be a stringed 
instrument player to use Power Chords . The Chord Request function allows you to harness your 
knowledge of chords no matter where that knowledge is based.

If your knowledge of chords is minimal, the Chord Request function still provides a valuable tool for 
experimenting with and learning about chords. You'll still be able to write music by 'feel' and learn as 
you go.

All rhythms and melodies in Power Chords are represented graphically. This allows you to use your 
musical skills to quickly produce whatever it is you wish.

If you have playing skills on a MIDI instrument, you can use that instrument as an input device. The 
ability to graphically edit and expand upon what you've played allows less facile players to make use of 
their instruments to full advantage. If you do not play an instrument, you can create graphically most 
anything that can be played.

Ease of use is stressed in the program. One of the main advantages is the direct feedback that you can 
get from any of the 'music elements' that exist in a song or in the palettes. You can use the right mouse 



button to sound or play any individual element in the program. This premise extends right into the 
configuration dialog boxes. With Power Chords, you can always get the feedback you need to allow you
to experiment, and to get results quickly and efficiently.



Installing and Configuring Power Chords
In order to get Power Chords working properly on your system there are a number of steps to 
undertake.

1: Install Power Chords.
2: Configure Windows properly for your sound hardware.
3: Set up the Power Chords MIDI options and test your Windows configuration.
4: Set up the Instrument MIDI Channel(s) and Patches.
5: Set up the Drum Sounds.
6: Set up the Drum Kit.
7: Plan Ahead.



1: Installing Power Chords
Check the file README.TXT on the Power Chords program diskette for late-breaking information that 
may not be included in any printed documentation, or in the help file. You can use the Windows 
Notepad application to view this file, or use the command TYPE A:README.TXT | MORE from the 
DOS prompt (assuming the diskette is in drive A:).

Install Power Chords. Insert the Power Chords program diskette and start Windows.

Run the Install program on the Power Chords program diskette. 
From the Program Manager, select    File from the menu at the top and then the Run... option. 

When prompted for the command line, specify the INSTALL.EXE program on the Power Chords 
program diskette. Don't forget to supply the diskette drive letter. 

For example, if the Power Chords program diskette is in drive A: supply the command line 

A:INSTALL. 

(If it's in drive B: supply the command B:INSTALL). Click on the OK button. 

This will run the Power Chords installation program. Follow the instructions given in the Power Chords 
installation program.

Note: Most of the files on the installation diskette are packed. These files end with the character $. If 
you should simply copy these files to your hard disk they will not be useful - they must be unpacked 
first. (When the install program is run, packed files are unpacked automatically.) Included on the 
installation diskette is an unpack utility - UNPACK.EXE. This is a Windows application that will unpack
the packed files.



2: Configure Windows for your Sound Hardware
You must tell Windows what hardware you have for making music with. This is done by loading drivers 
for your hardware. From the main program group, double click on the control panel icon. Then double 
click on the drivers icon. The drivers configuration dialog will show you which drivers are currently 
loaded. To load a driver for your hardware, click on 'Add'. Select the appropriate driver(s) for your 
hardware. If you have a diskette provided with the hardware and you don't see your hardware item on 
the list, select Unlisted or Updated Driver. You will be asked for the diskette and the driver will be 
loaded from it.

You may be asked for some setup information when you install your driver. For example, when installing
the MPU-401 driver, you are prompted for the Port and Interrupt number. If you are unsure about any 
setup values, try the default ones first.

Power Chords requires the Timer driver, which is automatically installed when you install Windows.

If you wish to use the MIDI mapper:

You will have to configure the Windows MIDI mapper before you can use it. Double click on the MIDI 
mapper icon on the Control Panel to start it. Now you can either modify the Default setup or create 
one of your own. Select Setups and then hit the New... button to create a new map, or select the 
default setup and then the Edit... button. In the Port Name column, you will have to tell the MIDI 
mapper which of the installed devices to use for each channel. For starters, we recommend setting all 
channels to the same device. Don't worry about the patch maps for now. Save your changes and exit 
the MIDI mapper by clicking on the Close button. (The Cancel button changes to Close when you 
make changes).

There is a detailed description on configuring the MIDI mapper for use with Power Chords in the section
entitled About Windows, MIDI, Drivers and the MIDI Mapper

For more information on the MIDI mapper, consult the on-line help file provided with Windows. You can 
access the help file by hitting the F1 key while accessing the MIDI Mapper.



3: Set up the Power Chords MIDI options and test your 
Windows configuration.

Please follow this section carefully. The majority of our support calls result from
people selecting the incorrect driver for their sound hardware. If you have 
trouble getting any sound, test each driver that appears in the Output Drivers 
list. Make sure that you have the correct Windows sound driver for you 
hardware, and make certain that you have the latest version of the Windows 
sound driver for your hardware installed.

Start Power Chords by double clicking on the Power Chords icon. Do not run the demo or tutorial until 
you have correctly configured Power Chords. 

Before Power Chords will output any sounds you have to tell it which of the installed sound device 
drivers to use.

Select an input and output driver. The first time you run Power Chords, you will be prompted to select
a MIDI Input and a MIDI Output device for Power Chords to use. You will be able to select from 
whatever drivers you have installed in Windows, plus the MIDI Mapper if it is installed.

The MIDI options can also be accessed by selecting 'MIDI...' from the Options menu.

The MIDI options dialog box has five sections in it.

1: MIDI Output driver - Select the output device you wish to use. Then click the Test Output 
Driver button. This causes a scale to be played, with each note on a different MIDI channel (the drum 
channel is skipped). You should hear a scale play up and then down, with a chord at the end. 

If you hear no sound, make sure your speakers are connected and working or try another output driver. (If
you have a sound board, play a .WAV file to make sure you can hear any output your sound board is 
producing. You can play .WAV files from one of many sound products which attach .WAV files to various 
system activities such as starting Windows, system errors, etc. Or use the Windows Sounds icon - click 
on "Control Panel" in the Main Window. Then click on the Sounds icon. Use the Test button to make sure 
you can play sounds through your sound board and speakers.)

MPC Sound Cards and Sound Blaster Compatibles - General Instructions:
Ad Lib Gold :
Advanced Gravis UltraSound:
Aria Based (AddTech Sound 2000, Alpha Systems Cyber Audio, AVM Alta Pro,
Computer Peripherals ViVa Maestro, Diamond Sonic Sound):
Media Vision Products:
MIDILand PCD-GM:
Roland SCC-1:
Sound Blaster:
Turtle Beach MultiSound:

Key Electronics Interfaces:
MIDIMAN Interfaces:
Music Quest MIDI Interfaces:
Roland MPU-401 MIDI interfaces and compatibles:



2: Drum channel - most sound boards and General MIDI modules have drum sounds on channel 
10. Try this channel first. If you have a Media Vision board (eg. Pro Audio Spectrum), try channel 16. If 
you want to try other channels, select Other Channel and enter the channel number in the edit box that
appears. 

To test the drum channel click the Test Drums button. This plays a drum part. Adjust the drum channel 
selection until you hear drum sounds instead of notes.

3: MIDI Input device - if you have a MIDI keyboard connected to a MIDI port in your computer, 
select the input device driver. 

If you are using an MPU-401 or compatible interface for output, and you have a MIDI keyboard 
connected to the MPU-401 input as well, select the same driver for input as you have for output (eg. 
Roland MPU-401 driver).

If you are using a sound card with no instruments connected to the MIDI port, select <None> 
for the input driver.

If you are using a sound card with MIDI option and you have a MIDI keyboard connected to 
the MIDI port, select the same driver for input as you have for output.

4: MIDI Thru channel - Ignore this option if you do not have a MIDI keyboard that you are using to 
input music into Power Chords.

MIDI Thru is used to direct the MIDI data coming in from a keyboard (or other MIDI device) back to a 
MIDI output channel. This is handy if you are using a MIDI controller that has no built in sounds (so you 
can hear what you are playing) or if you want to hear the sounds that are generated by the sound 
device connected to the output, rather than those of the input keyboard.

There are a number of options available for MIDI Thru:

<None> - turns MIDI Thru off.

Follow Rhythm Editor Channel - sends incoming MIDI data to the channel of whatever part is 
currently being edited in the Rhythm Editor. This is a very handy option if you are recording parts from 
the MIDI input.

Same as Input Channel - sends incoming MIDI data back out on the same channel it came in 
on.

Channel 1 thru Channel 16 - sends incoming MIDI data back out on the channel number 
selected no matter what channel it comes in on.

5: Patch Mapping - Almost all sound boards use General MIDI patch mapping - this includes 
the Sound Blaster and compatible boards, Media Vision, UltraSound, Ad Lib and MultiSound products, 
as well as boards based on the Aria chip set.

If you are using an older or non-General MIDI synth you may want to use numeric patch mapping 
and/or route patch changes through the MIDI Mapper

 If you are using a Roland GS compatible sound module, select Roland GS patch mapping. Roland GS



compatible products include the SCC-1, Sound Canvas modules, newer Roland keyboards, and the 
MIDILand PCD-GM card.

NOTE: If you do not have a Roland GS or General MIDI compatible sound module it is    recommended
that you use the General MIDI patch mapping in conjunction with the MIDI Mapper. You will have to 
create a patch map in the MIDI mapper that maps the General MIDI patch names and numbers in 
Power Chords to the actual patches available in your sound module. This is not too hard a task 
because the General MIDI patch names are listed right in the MIDI mapper dialog. If you follow this 
approach you will have the benefit of selecting patches in Power Chords by patch name, instead of 
constantly having to refer to your sound module documentation to look up patch numbers. 

See the Windows documentation for more information on the MIDI Mapper.

You can create MIDI Mapper patch maps for each of the different sound modules you might use. When 
you change modules, just change the patch map, and all your Power Chords files will still address the 
correct patches.

(Note: Some versions of the SoundBlaster card with MIDI option do not support MIDI input and output 
at the same time. Set the MIDI input device to <None> if you have a problem getting both to work. To 
rectify this situation, contact Creative Labs to get a new chip for your card.)



If you have a sound card with no MIDI devices attached use the driver for the on-board synthesis 
(often indicated by the words FM synthesis in the driver name) on the card provided by the 
manufacturer.

If your card has Ad Lib compatibility and you can't get any sound with the manufacturer's driver, try 
the Ad Lib driver which is shipped with Windows.

You may have to change the drum channel to 16 to get drum sounds with the Ad Lib driver. (Select 
Options from the Power Chords main menu and then Drum Sounds...). For more information see Set 
Up the Drum Sounds.Switch the drums to channel 16 if necessary.

If you have a MIDI device connected such as an external sound module, use the MIDI Output driver 
provided with the card. If you have a MIDI input device such as a MIDI keyboard connected to the card 
use the same driver for the Input Device. Otherwise leave the Input Device set to <None>.



If you are using a sound card based on the Sierra Aria chipset, and you have no MIDI instruments 
connected to it, use the Aria Multimedia Audio Driver for output.

If you have a MIDI devices such as an external sound module connected to the card, use the Aria MIDI 
Driver. If you have a MIDI input device such as a MIDI keyboard connected to the card use the same 
driver for the Input Device. Otherwise leave the Input Device set to <None>.



If you are using an Advanced Gravis UltraSound card without any MIDI instruments connected to it use 
the "UltraSound MIDI Synth" driver.

If you are using an Advanced Gravis UltraSound with a MIDI keyboard connected to it use the 
"UltraSound MIDI Output Port" driver.

To monitor UltraSound patch RAM left, select the Patch Memory Left item under the Help menu. To 
maximize the number of sounds you can put in UltraSound patch RAM (with a decrease in sound quality) 
configure the UltraSound driver with the Conserve    Memory option. (From Control Panel, double click 
on Drivers, then select Ultra Wave and MIDI Synth. Click on the Setup button. Click on the Conserve 
Memory button.)



If you are using an Ad Lib Gold card without any MIDI instruments connected to it use the Yamaha GSS 
Synth driver.

If you are using an Ad Lib Gold with a MIDI keyboard or external sound module connected to it use 
the Yamaha GSS MIDI Out driver. If you have a MIDI input device such as a MIDI keyboard connected 
to the card use the same driver for the Input Device. Otherwise leave the Input Device set to <None>.



If you are using the on-board FM synthesis on a Media Vision Pro Audio Spectrum Plus, or Pro Audio 
Spectrum 16 (ie. no MIDI instruments connected to the board), use the driver called "Voyetra FM Driver 
for PAS2".

If you are using a MIDI device such as a MIDI keyboard connected to the MIDI port on a Media Vision 
Pro Audio Spectrum Plus, or Pro Audio Spectrum 16 use the driver called "ProAudio MIDI Output".

If you are using a Thunderboard use the drivers that are shipped with it or the Ad Lib driver shipped with
Windows.

Note that you will have to change the drum channel to 16 to get drum sounds with Media Vision 
products. (Select Options from the Power Chords main menu and then Drum Sounds...).For more 
information see Set Up the Drum Sounds.



Use the "Roland MPU-401" driver provided with Windows. This will direct the output of Power Chords to 
the PCD-GM card.



If you are using a Sound Blaster Pro without any MIDI instruments connected to it use the "SB Pro 
Stereo FM" driver.

If you are using a MIDI device such as a MIDI keyboard or external MIDI module, connected to the MIDI 
port on a Sound Blaster Pro use the "SB MIDI Out" driver.

If you are using an older model Sound Blaster card (non-Pro) with no MIDI devices connected, use the 
Sound Blaster Windows driver provided with the card.    If this driver does not work, try the Ad driver 
(which comes with Windows 3.1). 

You may have to change the drum channel to 16 to get drum sounds with the Ad Lib driver. (Select 
Options from the Power Chords main menu and then Drum Sounds...). For more information see Set 
Up the Drum Sounds.Switch the drums to channel 16 if necessary.

If you have trouble getting sound, contact Creative Labs for the latest drivers for your board, as there 
have been many revisions of them.



Use the "Roland MPU-401" driver provided with Windows for the output driver. This will direct the output 
of Power Chords to the SCC-1.

If you have a Roland SCC-1 and you have a MIDI keyboard connected to the MIDI input on the card, 
you must also select the "Roland MPU-401" driver for the Input driver as well.

Make sure you select Roland GS patch mapping in the MIDI Configuration dialog and in the Drum 
Sounds dialog (both accessed from the Options menu in Power Chords).

If you have a MIDI keyboard or other MIDI input device connected to the MIDI input of the SCC-1, select 
"Roland MPU-401" for the MIDI Input driver as well. If you have no input devices connected to the 
interface, leave the Input Driver set to <None>.



If you are using a Roland MPU-401 MIDI interface or compatible, use the "Roland MPU-401" driver 
supplied with Windows, or a later version supplied by the specific manufacturer for output.

If you have a MIDI keyboard or other MIDI input device connected to the input of the MPU-401 or 
compatible interface, select "Roland MPU-401" for the MIDI Input driver as well. If you have no input 
devices connected to the interface, leave the Input Driver set to <None>.



If you are using a Music Quest interface, use the Music Quest MIDI Driver shipped with the interface. 
Make sure you have the latest version

If you have a MIDI keyboard or other MIDI input device connected to the input of the Music Quest 
interface, select Music Quest MIDI Driver for the MIDI Input driver as well. If you have no input devices
connected to the interface, leave the Input Driver set to <None>.



If you are using a MIDIMAN MM401 use the Roland MPU-401 driver for output, and for input if you have 
any MIDI input devices connected. If you have only output MIDI devices connected, and no input MIDI 
devices connected, leave the Input Device set to <None>.

If you are using MIDIMAN PORTMAN PC/P external parallel port interface, use the MIDIMAN PORTMAN
PC/P driver provided with the interface, and for input if you have any MIDI input devices connected. If you
have only output MIDI devices connected, and no input MIDI devices connected, leave the Input Device 
set to <None>.

If you are using MIDIMAN PORTMAN PC/S external serial port interface, use the MIDIMAN PORTMAN 
PC/S driver provided with the interface, and for input if you have any MIDI input devices connected. If you
have only output MIDI devices connected, and no input MIDI devices connected, leave the Input Device 
set to <None>.



If you are using a Key Midiator serial port interfaces use the Key Electronics MS-124 Port-1 driver. 
(There are similarly named drivers for some of the other Key interface models. 

Note that you may have to run Windows in Standard mode to use this interface (WIN /S).

Use the same driver for the Input Device if you are using a MIDI input device such as a MIDI keyboard. If 
you have only output MIDI devices connected, and no input MIDI devices connected, leave the Input 
Device set to <None>.



If you are using a Turtle Beach MultiSound, and you do not have any devices connected to the MIDI 
outputs, use the MultiSound Proteus driver to use the on-board synthesis.

If you have an external sound module connected to the MIDI output of the MultiSound, use the 
MultiSound Ext. Out driver.

If you have a MIDI input device such as a MIDI keyboard connected to the MultiSound, use the 
MultiSound Ext. In driver for input. Otherwise leave the input driver set to <None>.



4: Set up the Instrument MIDI Channel(s) and Patches
From the Options menu select the Tuning... menu item. At the bottom right of the dialog box are two 
buttons marked All. The upper one corresponds to the MIDI channel row of edit boxes. Enter the 
desired channel in the All box, and click the button. All the MIDI channels will change to match the 
entered channel. You may also want to set the patch now or at least experiment a bit. You can always 
come back and edit the settings another time.

When you set a patch for a single string, all strings that are on the same MIDI channel will also be set to
the same patch. If using Numeric patch mapping, simply enter the Patch value in the box. If using 
Roland GS or General MIDI patch mapping, click on the button marked P for the string you wish to 
change. Select a patch from the Select Patch dialog and then click OK.

To set all strings to the same patch: If using Numeric patch mapping, enter the patch in the bottom 
most box in the row of patches and click the All button to its right. If using Roland GS or General MIDI 
patch mapping, click the All button under all the P buttons. Select a patch from the Select Patch dialog,
click OK and the patch will be applied to all strings.

To test the channel and patch set ups, click the right mouse button in the dialog box. You should hear 
a note for each enabled string.

Once you have a set-up you are happy with, save it as the default set up by clicking on the Default 
button.

If you have not been able to get any MIDI notes to play up until this point: You may not have 
correctly installed your MIDI drivers. Or you may not have properly selected the devices to use in Step 3
above. Review the drivers that are installed - see Step 2. 

A Secondary test of your MIDI drivers can be accomplished by using the Media Player program 
which is installed by default in the Accessories program group as part of the MME. Close Power 
Chords, and start the Media Player. Click on the Device menu option. (Note - you will have to make 
sure the (MCI) MIDI Sequencer  is installed as a Driver). Select the MIDI sequencer and then load a 
MIDI file. There are some provided with the MME and Windows 3.1 with the extension .MID. If you can 
get the Media Player to play a MIDI file, then you will know that your drivers are properly configured and
the problem then lies in your Power Chords configuration.

Be aware that the Media Player uses the currently selected map in the MIDI Mapper to decide which 
MIDI output driver to use. If the map is not set up properly, you may not be able to get the Media Player 
to play.



5: Set up the Drum Sounds
From the Options menu select the Drum Sounds menu item. In the dialog that appears you can 
outline a 'palette' of sounds that you will have access to in the Power Chords drum kit.

If you are using a Roland GS Format compatible keyboard or sound module, select Roland GS from 
the Tone Mapping buttons. 

If you are using a General MIDI compatible keyboard or sound module, select General MIDI from the 
Tone Mapping buttons.

If you do not have a Roland GS Format or General MIDI compatible sound module, you can select the 
Other tone mapping and enter the drum sound layout, MIDI notes, and MIDI channel as needed. As 
with other patches mentioned above, it is highly recommended that you use the General MIDI layout, 
and then create a MIDI map for each sound module you use and let the MIDI mapper translate the 
General MIDI notes to match your sound module.This is important for ease of use reasons, and one 
other important reason. Drum sounds in the Drum Kit are mapped to note numbers by name. If you are 
using the standard General MIDI drum sound names, your files are more likely to usable with other 
Power Chords users' setups.

You can audition drum sounds by clicking with the right mouse button on the either the title or MIDI 
note edit box for each Drum Sound item.

You may save Drum Sound setups in files and reload them later.

As you click on each drum sound a combo box appears with a list of drum sound names in it. You may 
select from these or you may enter your own. It is highly recommended that wherever possible you use 
the drum sound names provided as this will provide compatibility between different Power Chords files. 
As mentioned above, the drum sound names are used to map from the Power Chords drum kit to the 
Drum Sounds.

When you have the Drum Sounds, MIDI channel, and metronome sound set up to your satisfaction, 
click on the Default button to save them as your default settings. Then click the OK button.

Special Note: Power Chords send out a patch change 0 on the drum channel when it starts up, as per 
the General MIDI guidelines. If you would prefer that this not occur, put the following line into the 
POWCHORD.INI file created in your \WINDOWS directory:

NoDrumPatch=1



6: Set up the Drum Kit
The Drum Kit is a subset of the drum sounds you set up in step 6. These are the drum sounds you 
can use in a song. The Drum Kit is saved in the song file and when reloaded, the drum sounds are 
mapped by name to the sounds specified in the Drum Sounds dialog box. Because of this, you can 
exchange Power Chords files with users who have different drum set ups and still get drum sounds like 
the ones you intended.

You can have up to 24 drum sounds in any one kit. This means that in any Power Chords song you can 
have access to 24 of the drum sounds available on your sound hardware.

From the Options menu select the Drum Kit... item. Access the different slots and select the drum 
sounds you want to use. You will be able to choose from the sounds listed in the Drum Sounds dialog. 
You can audition each sound by clicking with the right mouse button on each Drum Kit item.

Once you have a set-up you are happy with, save it as the default set up by clicking on the Default 
button. Click OK to end the Drum Kit dialog. Power Chords is now set up and ready for use.



7: Plan Ahead
Let's say the Instrument window set up to output on MIDI channel 2 and the Drum Kit is using MIDI 
channel 10. It is wise to plan ahead the channels you are going to use for Melodies and Bass Parts. 
Channel 3 for Melodies and Channel 4 for Bass Parts might be suitable in this example. Or you may 
want to follow the General MIDI channel designations.

 All the channels for each music element type should be unique. In other words, keep all Bass Parts on 
a single channel, all Melodies on a single channel etc. You will find Power Chords easier to work with if 
you use the same channels consistently from song to song especially for the Melodies and Bass Parts. 
(These channels are specified when you create a new rhythm in the Rhythm Editor and can also be 
set for existing Melodies and Bass Parts that are stored in their respective palettes.)

Make use of the No Patch Change patch. It is typical to use the same bass sound for a whole song, or 
for large parts of a song. If you make all the bass parts except the first one use the No Patch Change 
patch, then it is easy to change the bass part patch for the whole song by changing the patch in the first
Bass Part. All the following parts will use that patch.



Running the Tutorial Scripts:
Power Chords comes with a detailed, interactive tutorial. We highly recommend that you take the time 
to run the tutorial in order to quickly learn how to use Power Chords. The tutorial is the single quickest 
way to get up to speed on using Power Chords.

To run the tutorial, first make sure Power Chords is correctly configured for your sound hardware. 
(See Configuring Power Chords for detailed information). 

Start Power Chords.

From the Script menu, select the Load and Play Immediately option. 
Load the file TUTOR1.SCR.

There are three tutor script files in all, TUTOR1.SCR, TUTOR2.SCR, and TUTOR3.SCR. They are 
linked so that they can be run in sequence, one after the other, automatically.

However, if you wish to stop after any part of the tutorial, you can access the next part by loading the 
appropriate file.



Quick Start Guide:
The quick start guide is intended for users who are in a hurry to try out Power Chords, or already have a
good understanding of the installation of sound drivers, and the MIDI Mapper.

Prepare Windows by installing the Windows drivers you need to use your sound hardware if you have 
not already done so. 

Check the file README.TXT on the Power Chords program diskette for late-breaking information that 
may not be included in any printed documentation, or in the help file. You can use the Windows 
Notepad application to view this file, or use the command TYPE A:README.TXT | MORE from the 
DOS prompt (assuming the diskette is in drive A:).

Install Power Chords. Insert the Power Chords program diskette and start Windows.

Run the Install program on the Power Chords program diskette. From the Program Manager, 
select the Run... option from the File menu. When prompted for the command line, specify the 
INSTALL.EXE program on the Power Chords program diskette. Don't forget to supply the diskette drive 
letter. For example, if the Power Chords program diskette in drive A: supply the command line 
A:INSTALL. (If it's in drive B: supply the command B:INSTALL). Click on the OK button. This will run 
the Power Chords installation program. Follow the instructions given in the Power Chords installation 
program.

Start Power Chords. Double click on the Power Chords icon. Do not run the demo or tutorial until you 
have correctly configured Power Chords.

Select an Output Driver. The first time you run Power Chords, you will be prompted to select a MIDI 
Input and a MIDI Output device for Power Chords to use. You will be able to select from whatever 
drivers you have installed in Windows, plus the MIDI Mapper if it is installed. You can access the MIDI 
Configuration dialog box from Power Chords at a later time by selecting Options..., MIDI... from the 
Power Chords main menu.

Test the Output Driver. Using the Test Output button. You should hear an ascending and descending 
scale with a chord at the end. Each note of the scale is played on a separate channel. If you hear no 
sound, try a different driver and test again.

Test the Drum Channel. Most sound cards have drums on channel 10. If you are using the AdLib 
driver or a Media Vision card you may have to use channel 16. Test different channels until you get 
drum sounds instead of notes.

(Note: Some versions of the SoundBlaster card with MIDI option do not support MIDI input and output 
at the same time. Set the MIDI input device to <None> if you have a problem getting both to work. To 
rectify this situation, contact Creative Labs to get a new chip for your card.)

Select the Patch Mapping you wish to use - Roland GS, General MIDI, or Numeric.

For almost all sound cards, use General MIDI. For SCC-1, Sound Canvas, and the PC-DGM card use
the Roland GS setting.

It is recommended that if you do not have Roland GS or General MIDI compatible hardware you select 
General MIDI and use the MIDI Mapper to map the General MIDI patches to your sound hardware.

Select the Input Driver. If you are using a sound card with no MIDI instruments attached, leave the 
input driver set to <None>. 



If you are using the Roland MPU-401 driver for output, and you have MIDI instruments attached to the 
interface, select Roland MPU-401 driver for input as well. Similarly, for other compatible interfaces such
as Music Quest, or MIDIMan, or if using the MIDI cable on your sound card, use the same driver for 
input as you used for output.

Configure MIDI Thru: If you are using a MIDI input device such as a keyboard, and you have set up an
Input Driver, select the MIDI Thru option desired. The Follow Rhythm Editor option changes the 
routing of MIDI Thru to the same channel as whatever you are editing in the Rhythm Editor.

Configure other areas from the Options Menu:

Instrument - select the Tuning... option to change the tuning, number of strings, and MIDI channels 
and patches used by the strings. Select the Instrument... option to configure the instrument window.

Drum Sounds - select the Drum Sounds option to create a palette of drum sounds that map to your 
hardware. Check that the MIDI channel is correct for your hardware. Use the right mouse button in the
sound name boxes to play the drum sounds. Again, it is recommended that if you do not have Roland 
GS or General MIDI compatible hardware you select General MIDI and use the MIDI Mapper to map 
the General MIDI patches to your sound hardware.

Drum Kit - you can select 24 of the drum sounds set up in the Drum Sounds dialog to use in Power 
Chords at any one time. Use the right mouse button in the drum name boxes to audition them.

Run the Tutorial to understand how to put together songs in Power Chords.



MIDI Input Instruments and MIDI Thru:
Power Chords can record from MIDI instruments such as keyboards, to melody parts or bass parts. To 
do this, select Melody or Bass Part in the Rhythm Editor. Create a new part the length required. Then 
press the record button in the Rhythm Editor (marked Rec).

About MIDI Thru:

Many standard MIDI interfaces such as the Roland MPU-401 and compatibles can take MIDI input from
a keyboard and direct it immediately out on a MIDI channel to an attached sound module, as well as 
passing it in through the interface as normal. This is handy when you are using a MIDI controller that 
has no built in sounds such as the Roland PC-150, PC-200, or the Novation MM10.

However, Windows shuts off the MIDI Thru capability of MPU-401 compatible interfaces. Power Chords 
provides an extensive software based MIDI Thru capability with a number of options.

To set MIDI Thru, select Options from the main menu, and then MIDI... to get the MIDI configuration 
dialog. To get MIDI Thru working, you must select the correct input device and then select the MIDI Thru
option you desire.

MIDI Thru Options:

<None> Turns MIDI Thru off.

Follow Rhythm Editor Channel This sends any MIDI input back out on the same channel as 
the music element being edited in the Rhythm Editor. For example, if you are editing a Drum part, 
whatever you play in will be sent back out on the current drum channel (likely channel 10). Then if you 
drag a Melody to the Rhythm Editor that is on channel 4, anything played in will be sent back on 
channel 4.

Same as Input Channel Whatever is played in will be sent back out on the same 
channel that it was received.

Channel 1
thru
Channel 16 Whatever is played in will be sent out on the specific channel 
selected.



Power Chords Information:
Minimum Number of Strings on Instrument: 2
Maximum Number of Strings on Instrument: 12
Minimum Number of Frets on Instrument: 4
Maximum Number of Frets on Instrument: 24

Maximum Number of Chords in Palette: 48
Maximum Number of Chord Rhythms in Palette: 24
Maximum Number of Drum Parts in Palette: 24
Maximum Number of Melodies in Palette: 24
Maximum Number of Bass Parts in Palette: 24
Maximum Number of Controls in Palette: 24

There are hidden palettes in the Song for each Rhythm Type. They have the same capacities as the 
regular palettes. So for example, the maximum number of different Chord Rhythms in a song is 24.

Maximum Number of Bars per Rhythm: 16
Melodies and Bass Parts imported from MIDI files are allowed to exceed 16 bars.

Number of Chords in Bar: 4
Minimum Number of Beats per Bar: 2
Maximum Number of Beats per Bar: 6
Number of Bars in Song: 128

Minimum Tempo: 32 Beats Per Minute
Maximum Tempo: 256 Beats Per Minute
Internal Clock Resolution: 96 ticks per quarter note.
Minimum Note Length: 1/96th of a quarter note.

Number of Drum Sounds in Palette: 74
Number of Drum Sounds in Kit: 24

Maximum Notes in Rhythm Editor Playback Buffer: 4096 notes or 8192 MIDI Events
Parts can be longer than this - playback will be truncated in the Rhythm Editor or when played by 
clicking with the right mouse button.
The total number of MIDI Events in a song is limited by the amount of available memory.

Maximum Script Size: 32768 characters.

Acknowledgements:

Power Chords was created by Eric and Karen Bell.
Special recognition for achievements in vocal work to Jinx.



About Windows, MIDI, Drivers and the MIDI Mapper:
This section describes how Windows handles your sound hardware, and why you should configure 
Power Chords for General MIDI and use the MIDI Mapper if you don't have a General MIDI or Roland 
GS compatible sound source.

(If you have a General MIDI compatible sound source, configure Power Chords to use General MIDI 
patch mapping. You do not need to use the MIDI Mapper.)

NOTE: Virtually all sound cards (Sound Blaster and compatibles, Media Vision, Ad Lib and 
compatibles, UltraSound, cards based on the Aria chip set, etc. etc.) are General MIDI 
compatible. You will not have to use the MIDI Mapper if you are using one of these devices.

(If you have a Roland GS Format compatible sound source, you can configure Power Chords to use 
either General MIDI or Roland GS patch mapping (Roland GS is recommended to give access to the 
additional GS capabilities).You do not need to use the MIDI Mapper.)

How Power Chords makes music

Power Chords sends out MIDI messages - electronic codes such as 'Note On', 'Note Off', and 'Patch 
Change'. These messages are what triggers your sound hardware to play notes or to change instrument 
sounds.

Windows is involved in all of this as well. Windows provides a way for Power Chords to send out one set 
of codes, and to have these work with whatever sound hardware you have installed. There is an 
intermediate piece of software that does the translation from Power Chords to your sound hardware 
called a driver.

This is why you have to select the MIDI input and output devices inside Power Chords - so Windows 
knows where to route the MIDI messages Power Chords is sending, and how to do any translation that is 
necessary for the hardware.

This is also why you have to install the sound drivers for your hardware from the Drivers applet in 
Windows before you can make any music. When you bring up Power Chords' MIDI options dialog to 
select the input and output devices you can choose only from those drivers which you have installed in 
Windows. 

Here is the 'signal path' of a MIDI message coming from Power Chords:

Power Chords -> driver -> sound hardware -> music notes

Patch Changes

A patch change is a type of MIDI message that tell the sound hardware which music sound to use on a 
particular MIDI channel. There are sixteen channels in all - each can have a different patch setting if 
desired. This is how sound hardware can play different sounds at the same time - the MIDI note 
information for each instrument is on a different channel.

A patch change command can specify a patch number from 1 through 128.

General MIDI



Under General MIDI, patch 1 is always piano. Trumpet is always patch 57, flute is always patch 74, and 
bagpipe is always patch 110.

If your sound device is not General MIDI compatible, the instrument patch names in the Power Chords 
menus will not match the patch numbers of those sounds on your sound device. In this case, the MIDI 
Mapper can be used to translate the General MIDI patch numbers to those matching your sound 
hardware. This will let you still use the instrument menus in Power Chords. As well, your sequences will 
be compatible with all General MIDI devices.

The MIDI Mapper

The MIDI mapper is provided with Windows 3.1. The MIDI mapper is a 'converter' and it is available to be 
used as an output device in Power Chords.    It can convert General MIDI patch numbers to the patch 
numbers that match your non-General MIDI sound module.

Here is the 'signal' path of a MIDI message when using the MIDI Mapper:

Power Chords -> MIDI mapper->driver -> sound hardware-> music notes
General MIDI converts patch receives patch
flute patch 74 to patch 2 2 - switches 
(patch 74) to flute sound

In order for the MIDI Mapper to translate patches correctly,    you have to set it up so that it knows which 
patch numbers on your sound module match the General MIDI instrument patches.

More and more people are creating MIDI information (song files, standard MIDI files, etc.) that are 
compatible with the General MIDI patch mapping. It is in your interest to use General MIDI if you can. And
it makes Power Chords a lot easier to use, since you can select patches by name, instead of by number.

Configuring the MIDI mapper

(Please note that there is full documentation available from within the MIDI Mapper. Just click on the 
'Help' button, or press the F1 key while the MIDI Mapper dialog is up. These instructions are here to try to 
clarify some of the aspects of the MIDI Mapper and to allow you to quickly get results with Power Chords. 
Also, note that the MIDI Mapper is very versatile. You can get the MIDI mapper to do all sorts of complex 
things (like mapping individual keys) that we won't get into here.)

How do you set up the MIDI mapper? First, double click on the Control Panel icon in Program Manager. 
Now double click on the MIDI mapper icon.

If there is no MIDI mapper icon, you may have to install it. Double click on the 'Drivers' icon in the 
Control Panel. Select MIDI mapper from the list of drivers and then click on the 'Add...' button.

Make sure you have already installed the drivers for your sound hardware. If you haven't, install them 
from the Drivers applet by selecting from the list and clicking the 'Add...' button. If you don't see the driver 
for your sound hardware, and you have a diskette supplied by the manufacturer with the driver on it, 
select 'New or Updated Driver' to read it from the diskette.

Now that the MIDI mapper configuration dialog is up, you have to create two things - a patch map to 
convert General MIDI patches to match your hardware, and a setup to link in the patch maps to each 
channel.

First of all, check to see if there is a default map already available for your sound hardware. Click on the 
'Setups' button. Now click on the button to expand the combo box with the list of setups in it. If you see a 
setup and description that matches your hardware, all you have to do is select it, and the select 'Close'. 
You may be asked to restart Windows in order for the new selection to take effect.



For example, there is an MT-32 setup already included with the default MIDI Map, created when Windows
is first installed.

If there is no default Setup selection that matches your hardware, you will have to create one. First, click 
on the Patch Map button.

Now click on the New button to create a new map. A screen will appear that looks partially like the 
following. 

All you have to do is to match up the instrument descriptions with the patch numbers for your hardware, 
which should be listed with its documentation.

At the top of the dialog is a box which switches the way patches are numbered. They can be numbered 
starting from 0 or from 1. Select the patch numbering scheme that matches the way patches are listed in 
your sound hardware documentation.

If you do not have an patch to match a particular instrument, select a patch for one that is similar. For 
example if your sound hardware has a flute patch but no piccolo patch, use the flute patch in both the 
flute and piccolo slots.

Once you have created your map, click on the 'Save' button and enter a name for it. Now the hard part is 
done.

Back in the main part of the MIDI mapper dialog box, click on the 'Setup' button. Then click on the 'New' 
button to create a new setup.

You will see a new dialog that looks like the following.

In the column marked Port Name you will have to select the driver for your hardware. For example if you 
are using an MPU-401, then you should have installed the MPU-401 driver previously and you would 
select the MPU-401 drivers for all 16 channels.

In the column marked Patch Map Name, select the map you created previously for all sixteen channels.

When you are done your results would look similar to the following, if you were using the MPU-401 driver.



Save the setup by clicking on the 'Save' button. Now close the MIDI Mapper. You may be asked to restart 
Windows to make the change effective.

Now that you've created a MIDI Mapper setup, all that's left is to configure Power Chords to use the MIDI 
Mapper for output. Select the 'MIDI...' item from the 'Options...' menu in Power Chords. For the output 
device, select the MIDI Mapper. For Patch Mapping, select General MIDI. 

Note: If you have a Roland GS Format compatible instrument, you can use it directly without creating a 
MIDI Map for it - the patches are already General MIDI compatible. However, be sure to select GS Format
Patch Mapping in the MIDI options dialog in Power Chords to take advantage of the extended instrument 
tones available with GS Format.

Now you will be able to select patches by instrument name instead of by number in Power Chords. You'll 
be able write Power Chords files and MIDI files that more people can enjoy. And you'll be able to use 
others Power Chords files more readily, if they conform to the General MIDI specification.

In addition, you can use the MIDI Mapper as the Windows Media Player's device so that you will be able 
to play MIDI files that conform to the General MIDI specification.

MIDIMAP.CFG

All the MIDI map information including patch maps and setups are stored in a file called MIDIMAP.CFG. 
Many sound card installation programs install their own copy of this file overtop of the one that was there 
before. (They also usually make a backup copy of this file - MIDIMAP.OLD for example). Microsoft has not
provided any way for a program to insert or remove patch maps from an existing file. This means that 
wholesale replacement of the file is they only way for a sound card to install a map for itself. This means 
that any maps you may have created may disappear when you install the software for a sound 
card. The only way to insert or remove an individual map or setup is to do it manually. If you find this 
situation causes you grief, we would ask that you suggest to Microsoft that they release the file format for 
the MIDIMAP.CFG file and/or some routines to access it.

Roland GS Format

Roland GS Format is a superset of General MIDI. In other words, it does everything General MIDI does 
and more. In addition to having the same patch mapping as General MIDI, other MIDI messages are 
defined for controlling other parameters in GS Format instruments. For example, Control Change 91 
sets the reverb level for any GS format instrument. For more information check the documentation for 
your GS format instrument or sound module.



File Menu
New
Open
Save
Save As
Export to MIDI File
Exit



Options Menu
Instrument
Tuning
Drum Sounds
Drum Kit
MIDI



Palette Menu
Clear Chord Palette 
Clear Chord Rhythm Palette 
Clear Drum Rhythm Palette 
Clear Melody Palette 
Clear Bass Part Palette 
Clear Control Palette 



Song Menu
Song Options
Dump Song Chords to Palette
Dump Song Chord Rhythms to Palette
Dump Song Drum Rhythms to Palette
Dump Song Melodies to Palette
Dump Song Bass Parts to Palette
Dump Song Controls to Palette
Zap Song



Script Menu
Script Facility Description
Script Commands Listed

Functions:

Load
Load And Play Immediately
Play
Record
Save



Window Menu
The Window Menu contains some options to help you manage the different Power Chords Windows.

Cascade Cascades any Power Chords windows that are not minimized.
Arrange Icons    Arranges the icons for any minimized Power Chords windows at the bottom of the 

screen.

Selecting any of the following options restores the selected window if it is minimized. This also brings 
the window up to the front of all non-minimized windows.

1 Instrument
2 Song
3 Rhythm Editor
4 Chord Palette
5 Chord Rhythm Palette
6 Drum Rhythm Palette
7 Melody Palette
8 Bass Part Palette
9 Control Palette
0 Tempo
Staff



Help Menu
Panic Button
Help
Suspend MIDI
Patch Memory Left
About



File New

This menu option clears all information in the Song window, and all Palette windows as well.    It does 
not affect what is in the Rhythm Editor.    If you have made changes to the current song, you will be 
prompted to save them before the song is cleared.



File Open

This menu selection allows you to open a previously saved Power Chords song file.    The default 
extension for a power chords file is '.POW'.    If you have made changes to the current song, you will be 
prompted to save them before a new file is opened.



File Save

This menu selection allows you to save the current song information in a Power Chords song file.    The 
first time this is selected you will be asked for a file name.    Thereafter, until you change file names, the 
previously specified file will be overwritten with the changes.    The default extension for a power chords 
file is '.POW'.    Power Chords song files are not the same as Standard MIDI files.    If you want to save a
song as a Standard MIDI file, use the File Export to MIDI File menu option.



File Save As

This menu selection allows you to save your current song information in a Power Chords song file.    
You will be specifically prompted to enter the file name.    The default extension for a power chords file is
'.POW'.    Power Chords song files are not the same as Standard MIDI files.    If you want to save a song
as a Standard MIDI file, use the Export to MIDI File menu option.



File Export to MIDI File

This menu selection allows you to save the current song information in a type 1 Standard MIDI File.    
This allows other sequencers and music programs to read in your Power Chords song.

Each track of music information from the Power Chords song is written to a separate MIDI file track (eg. 
Chord Rhythms, Drum Rhythms, Melodies, etc. are all written to separate MIDI file tracks).

Intelligent arranger data is not written to the Standard MIDI file, nor are MIDI timing commands.



File Exit

This command will end Power Chords.    If you have unsaved changes in your Power Chords song, you 
will be prompted to save them if you wish.



Instrument Options
This menu option invokes the Instrument Options dialog box which has the following items in it:

Fretboard Display    The Show Dots button will cause the normal finger dots to be drawn on the 
fretboard where the 'fingers' are placed.    The Show Note Names button will cause the
letter note names of the notes selected to be drawn on the fretboard where the 'fingers' 
are placed.

Hammer On Delay    There are three buttons available to set standard delays for hammer ons (or grace
notes).    The delay is the number of clock ticks Power Chords waits after a string is 
played to play the hammer on note.    There are 96 clock ticks per quarter note.    
Selecting the Quarter button sets the delay to 96.    Selecting the Eighth button sets 
the delay to 48.    The Sixteenth button sets the delay to 24.    If none of these values is 
desired, you can use the edit box to set the delay to whatever value you want.

Top Display The Normal Symbols button selects the normal guitar chord symbols to be displayed 
at the top of the fretboard (ie: o for open strings, x for blocked strings, nothing for fretted
strings).    If Show Note Names is selected, the letter note name of note selected on 
the string is displayed.    If Show MIDI Notes is selected, the MIDI value for the note 
selected on the string is displayed.

Show Bar Markers    Turns on and off the rectangular bar markers drawn on the 3rd, 5th, 7th, 9th etc. 
frets.    Having these on makes it easier for some guitarists to use the fretboard.

Auto Chord Naming    When this is selected, every note changed on the fretboard causes the chord 
name to be re-calculated.    The simplest name found is used for the chord name.    (If 
this name is not desired, it can be changed via the Name button on the fretboard).



Tuning Options
This invokes the Tuning Options dialog box which allows you to set up the instrument the way you want 
it.    Great flexibility is available in setting up the strings in Power Chords.    Strings can be tuned any 
way you like, and you can assign any MIDI channel to any string.    Each channel used can have its own
MIDI Patch as well.    Each string has one of the following controls:

Note This displays the note name the string is tuned to.    It changes when the MIDI note edit 
box is changed or when the tuning scroll bar is moved.

MIDI This displays the MIDI note the string is tuned to.    If you wish, you can enter a MIDI 
note value directly into this box.    This will update the Note display and the tuning scroll 
bar as well.

Tuning Scroll Bar    This scroll bar changes both the Note display and MIDI edit box.    Clicking with the 
right mouse button will sound the string at the tuned value, on the current channel and 
with the current patch selected so you can audition any individual string setup.

Chan. Enter the MIDI channel you want the string to transmit on in this box.

Patch. Enter the MIDI patch number for the string in this box.    Note that any changes to a 
patch number are also applied to strings on the same channel.    This is because only 
one patch can be set on a particular MIDI channel at a time.    Any secondary patch 
changes would override the previous ones.

When using Roland GS or General MIDI patch mapping, the patch names are 
displayed instead of the Edit Patch box. To change the patch for a string, click on the P 
button to invoke the Select Patch dialog.

Other Controls in the dialog box are:

# Strings Use the up or down arrows next to the number of strings display to change the number 
of strings you wish to have on the instrument.    You can have between 2 and 12 strings.

# Frets Use the up or down arrows next to the number of frets display to change the number of 
frets you wish to have on the instrument.    You can have between 4 and 24 frets.

Chan All You can enter a valid MIDI channel number in this box.    When you press the 'All' 
button next to it, all strings will be assigned to this MIDI channel.    The patch selected 
for the first string will be applied to all channels.

Patch All You can enter a valid MIDI patch number in this box.    When you press the 'All' button 
next to it, all strings will be assigned this patch number, regardless of what channel they
are assigned to.

When using Roland GS or General MIDI patch mapping,    click on the P button next to the Patch All 
button to invoke the Select Patch dialog. When you select a patch from this dialog, it 
will be applied to all strings.

Save You can save instrument setups in a file.    The default extension is '.AXE'.

Load Use this button to load a previously saved '.AXE' file.

You can use the right mouse button to sound an individual string/channel/patch combination by 
clicking on the tuning scroll bar for the string.    If you click the right mouse button while not on any 



control (ie: on a blank area of the dialog box) all activated strings/patches will sound.    This is a handy 
way of trying out patches before okaying an instrument setup.



Drum Sound Options
Power Chords supports a palette of up to 74 Drum Sounds from which you can pick 24 to use in the 
Drum Kit for a song.

If you are using the Roland GS patch mapping, just click on the Roland GS button to automatically load
the Roland GS sounds. Then you can select one of the Roland GS drum sets as well.

If you are using the General MIDI patch mapping, click on the General MIDI button to load the General 
MIDI sounds.

If you are using the Other patch mapping, you can set up the drum sounds and MIDI notes to match 
your sound module. However, it is highly recommended that you use the General MIDI setup, and 
then use the MIDI Mapper to map the General MIDI sounds to your sound module instead of using the 
Other patch mapping.

You can enter your own Drum Sound Names into the boxes or you can select from the ones provided in
the combo box that appears when you click on a Drum Sound entry box. It is best if you choose from 
the sounds provided so that Power Chords will have a better chance at mapping sounds selected in the 
Drum Kits from other song files to the sounds in your sound module.

Title Enter the title for the drum sound setup here.

Channel Enter the MIDI channel you want drum sounds to go out on here.

Save You can save drum sound setups in a file.    The default extension is '.SND'.

Load Use this button to load a previously saved '.SND' file.

Default Click on this button to save the current setup as the default one to be loaded when you 
start Power Chords.

Metronome Channel    Enter the channel for the metronome note to be used in Power Chords here.

Note Set the MIDI note to use for the metronome sound here.

Tone Mapping You can select from either Roland GS, General MIDI, or Other drum sound mappings 
(see above).

Roland GS Set    The Roland GS standard supports different 'drum sets' - for example there Standard, 
Electronic, Jazz, etc. You can select the one you want to use from the entries in this 
combo box.

To test a Drum Sound, click on either its name or the MIDI note edit box with the right mouse button.

There are many more Drum Sound entries than will fit on the screen. To view and edit them all, use the 
scroll bar on the right side of the Drum Sound dialog box.

When you have the Drum Sounds set up the way you want, click on the Default



Drum Kit Options
There are 24 drum sounds in a Power Chords Drum Kit.    This menu option brings up the Drum Kit 
dialog box through which drum assignments can be accessed and changed.    Each of the 24 drum 
sounds has an Instrument title edit box.    Select the sounds you want in the Drum kit by clicking on a 
name box and selecting from the sounds in the list box that appears.

Save You can save drum kit setups in a file.    The default extension is '.DRM'.

Load Use this button to load a previously saved '.DRM' file.

You can use the right mouse button to sound individual drum sounds by clicking on the Instrument title
box for that sound.    This is a handy way of trying out drum sounds before okaying a Drum Kit setup.



Clear Chord Palette

This clears all chords from the Chord Palette.    Chords that are in use in the song can be reloaded to 
the Chord Palette by selecting the Dump Song Chords To Palette option from the Palette menu.



Clear Chord Rhythm Palette

This clears all chord rhythms from the Chord Rhythm Palette.    Chord Rhythms that are in use in the 
song can be reloaded to the Chord Rhythm Palette by selecting the Dump Song Chord Rhythms To 
Palette option from the Palette menu.



Clear Drum Rhythm Palette

This clears all drum rhythms from the Drum Rhythm Palette.    Drum Rhythms that are in use in the song
can be reloaded to the Drum Rhythm Palette by selecting the Dump Song Drum Rhythms To Palette 
option from the Palette menu.



Clear Melody Palette

This clears all melodies from the Melody Palette.    Melodies that are in use in the song can be reloaded 
to the Melody Palette by selecting the Dump Song Melodies To Palette option from the Palette menu.



Clear Bass Part Palette

This clears all Bass Parts from the Bass Part Palette.    Bass Parts that are in use in the song can be 
reloaded to the Bass Part Palette by selecting the Dump Song Bass Parts To Palette option from the 
Palette menu.



Clear Control Palette

This clears all controls from the Control Palette.    Controls that are in use in the song can be reloaded 
to the Control Palette by selecting the Dump Song Controls To Palette option from the Palette menu.



MIDI Options
This invokes the MIDI options dialog box which has the following controls in it:

MIDI Input Device    This combo box allows you to select the device you want to use for MIDI input into 
Power Chords.

MIDI Output Device    This combo box allows you to select the device you want to use for MIDI output 
from Power Chords.

MIDI Devices are drivers which are installed in your system via the Windows Drivers applet. They 
allow the Windows to access your sound or MIDI hardware. If you have not installed any sound or MIDI 
drivers, none will be available in either of the MIDI options combo boxes.

There is detailed information on loading drivers and configuring the MIDI mapper for use with Power 
Chords in the section entitled About Windows, MIDI, Drivers and the MIDI Mapper

Patch Mapping    This is a group of three buttons that indicates how you want Power Chords to handle 
patches (instrument tones used by your sound hardware). If you are using a Roland GS Format 
compatible sound module, select Roland GS for your mapping. This allows you to work with the GS 
Capital tones, sub-capital tones, and variant tones by their text names when selecting or displaying 
patches.

If you have a General MIDI compatible sound module, select the General MIDI option. This allows you 
to work with the General MIDI tones by their text names when selecting or displaying patches.

If you select Numeric, you will select and display MIDI patches by their MIDI number.

Even if your sound module is not General MIDI compatible, it is highly recommended that you select 
General MIDI patch mapping in Power Chords, use the MIDI Mapper as the MIDI output device, and 
create a MIDI Map to translate the General MIDI patch numbers to the instrument sounds on your 
sound hardware.



Song Options
This invokes the Song Options dialog box which has the following controls in it:

Display You can select any or all of the following tracks to be displayed in the song window: 
Chord Pictures, Chord Names, Chord Rhythms, Drum Rhythms, Melodies, Bass Parts, 
and Controls.    When a track is not selected for display it is still in the song and may still
be played - it just isn't shown in the Song window.

Play You can select any or all of the following tracks to be included when the Song is played:
Chord Rhythms, Drum Rhythms, Melodies, Bass Parts, and Controls.    A track may 
show in the Song window (ie: be selected for display) and still not be played.

Song Options can be altered during song playback and will take effect.

Selecting the All box for either Display or Play alternately turns all items on or off.

Transpose playback Power Chords can transpose your song to any key you want. To turn 
off transposition, select <None> (default setting). To transpose higher, select the 
number of plus half steps required (eg. +1, +2). To transpose lower, select the number 
of minus half steps req uired (eg. -1, -1 etc.).

The transposition setting also affects any exported standard MIDI files - the notes in 
the file will be transposed.

Title Enter the title of the song here. This information is included when you export your 
Power Chords song to a standard MIDI file as a text item

Beats Per Bar The number of beats per bar for the entire song is entered here.    Values from 2 
through 6 are acceptable.    Note that changing this value for an existing song may yield
unexpected results when playing melodies or bass parts with drum and chord rhythms -
the lengths of existing rhythms are not changed when this value changes.

Bars Per Line This changes the number of bars shown per line of the Song window.    Values from 1 
through 24 are accepted.

Lead In Bars This sets the number of 'count in' or 'lead in' bars that are played before the beginning 
of the song.    Even if the metronome is turned off, the metronome will still sound using 
the metronome settings described below during the lead in bar(s).

Send MIDI Clocks    Select this if you want to sync an external module such as a drum machine or 
intelligent arranger to Power Chords.    When this is selected, the standard 24 click per 
quarter note MIDI clock values will be sent while the song is playing.    In addition, a 
MIDI Song Start command will be sent when the music starts, and a MIDI Song Stop 
command will be sent when it is over or stopped.    Make sure you set the MIDI clock 
selection on the module to 'External' to get it to use the Power Chords clock signal.

Intelligent Arr. This turns on support for intelligent arranger modules such as Roland's RA-90.    When 
this is selected, a special track of chord information is set up and sent.    When a chord 
change is encountered, each note of the chord is shifted down below MIDI note 12.    
The notes are sent out just before the beat so that the intelligent arranger has time to 
sense the chord change.    The notes last till just after the beat.    Set the 'Chord Hold' 
feature on the Intelligent Arranger 'on' for proper results.    The chord information is sent
on the channel specified in the Chan edit box and is independent from Chord Rhythms. 
Make sure that the Instrument strings are not sending to the same channel as the 



Intelligent Arranger.    

Chan The Chan box to the right of the Intelligent Arr.    box is used to enter the MIDI channel 
for the Intelligent Arranger information to be sent on.

Metronome Select this box to let the quarter note metronome run throughout the song.    Note that 
even if this is turned off, the metronome values set will still be used to sound the 
metronome during lead in bars, if any are selected.

You can use the right mouse button on any of the metronome fields to audition the metronome 
channel/patch setup.



Dump Chords to Palette

This puts one copy of each different chord found in the song in the Chord Palette



Dump Drum Rhythms to Palette

This puts one copy of each different Drum Rhythm found in the song in the Drum Rhythm Palette



Dump Chord Rhythms to Palette

This puts one copy of each different Chord Rhythm found in the song in the Chord Rhythm Palette



Dump Melodies to Palette

This puts one copy of each different Melody found in the song in the Melody Palette



Dump Bass Parts to Palette

This puts one copy of each different Bass Part found in the song in the Bass Part Palette



Dump Controls to Palette

This puts one copy of each different Control found in the song in the Control Palette



Zap Song

This clears all the song information including Chords, Chord Rhythms, Drum Rhythms, Melodies, Bass 
Parts, and Controls.    It does not affect the contents of the Rhythm Editor, or the Palettes.



Load Script

This loads allows you to load a Power Chords Script file. After selecting Load Script, a file name entry 
dialog box appears that allows you to select the file to load. The default extension of script files is 
'.SCR'.    A script file contains a series of commands for Power Chords to execute.    These commands 
can be used to make up tutorials, lessons, or interactive presentations.



Load And Play Immediately

This command invokes a file name entry dialog box for you to specify a Power Chords script file to be 
loaded and played immediately after loading is complete. 



Play Script

This plays the current script loaded into Power Chords.    If no script is loaded, the menu option is not 
available.



Record Script
This starts the recording of a Power Chords script.    If there is an unsaved script loaded when this is 
selected, you are prompted to save it.

When this menu item is selected, recording has begun and the text for the menu item changes to Stop 
Recording.    In addition, the Recording window is displayed.    Select Stop Recording when you are 
done recording your script.    Then select Save if you wish to write the script to a file.

Script files consist of a series of actions such as moving a particular chord to the fretboard, displaying 
text, or asking a multiple choice question.    The commands are put into the script files in two fashions 
once recording has begun.    Some actions are performed directly in Power Chords, and are recorded to
the script file automatically.    When this occurs the computers speaker beeps.    Other actions are 
selected from the script menu.    When they are complete and an item is added to the script file, a beep 
is also heard.

Here is a list of the actions you can do in Power Chords that are recorded automatically in a script file, 
and an example of the command stored in the file:

When you start recording a script, the positions of all windows are recorded -
RESTORE INSTRUMENT 10, 20, 30, 60
MINIMIZE SONG
MAXIMIZE RHYTHMEDIT

Loading a song file - LOAD SONG TUTOR1.POW
Selecting a New from the file menu - LOAD NEW
Loading an Instrument file from the Tuning Options dialog box - LOAD INSTRUMENT 

DEFAULT.AXE
When a chord is moved:
- to a bar in the Song Window
- to the Chord Palette
- to the Staff Window

MOVE CHORD "GMAJ" 3, 2, 0, 0, 0, 3 TO STAFF

To record the movement of a chord to the Instrument Window, move the chord into place and 
select the Script menu item MOVE CHORD (see below).

Script commands you can insert into a script by selecting from the menu are:

MOVE CHORD
DISPLAY
DISPLAYTIMED
MULTIPLE CHOICE
PAUSE
PLAY SONG

There are also some actions that can only be added to a script file by editing them with a text editor:
MCI
RESTORE
REM



Save Script

This saves the current script to a file name.    The default extension is '.SCR'.



Script Commands
The following is a list of all the script commands.

REM
DISPLAY
DISPLAYTIMED
LOAD SONG
LOAD INSTRUMENT
LOAD NEW
MCI
MOVE CHORD
MULTIPLE CHOICE
PAUSE
RESTORE
MINIMIZE
MAXIMIZE
PLAY SONG
LOAD SCRIPT



REM <text>

Allows you to put comments in your script files. Lines that begin with REM are not executed or displayed 
by Power Chords.

How added to script: only by editing a script file.

Example: 

REM Guitar tutor script Version 1.1



DISPLAY "<text>"
DISPLAYTIMED <seconds> "<text>"

Both of these display up to five lines of text in a box that has a scroll bar and a button labelled 'GO' which,
when clicked on, removes the box. The DISPLAYTIMED type box removes itself if the button is not 
pushed in the specified number of seconds.

How added to script: Either DISPLAY or DISPLAYTIMED can be selected from the script menu. A dialog 
box is used to enter the text you want displayed, and the length of time if applicable.

Example:

DISPLAY "The strings of a normal six string guitar are tuned with the
following pitches, from lowest to highest: E, A, D, G, B, and E."

DISPLAYTIMED 10 "Welcome to the self running demo version of Power Chords. We
hope you enjoy it."



LOAD SONG <filename>

Loads the Power Chords file specified.

How added to script: by selecting the 'Open' command off the File menu when recording a script.

Example:

LOAD SONG TEST.POW
LOAD SONG D:\POWCHORD\ROCKER.POW



LOAD INSTRUMENT <filename>

Loads the instrument file specified. This has the same effect as loading an instrument file from the Tuning 
Options dialog box, accessed through the Options menu item.

How added to script: by clicking on the 'Load' button in the Tuning Options dialog box and loading an 
instrument file, while recording a script.

Example:

 LOAD INSTRUMENT BAGPIPES.AXE



LOAD NEW

Load New has the same effect as selecting NEW under the File menu item. It clears all song information, 
and all palettes. This does not clear the contents of the Rhythm Editor.

How added to script: by selecting the 'New' command off the File menu when recording a script.

Example: 

LOAD NEW



MCI

This is an extremely powerful script command which allows you to access the Windows Media Control 
Interface (MCI).
MCI is a text language with which you can give commands to Windows to control the various multimedia 
devices which may be installed on an MPC system. These devices include the MCI MIDI Sequencer, CD-
ROM drives, MCI Wave player etc.

The string after the keyword MCI is passed to the Windows function mciExecute().

How added to script: only by editing a script file.

This example opens the wave output device, plays a wave file, and closes the device:

MCI open waveaudio
MCI play howldog.wav
MCI close waveaudio

This example opens the cd player and does various things with it.

REM First, we open the CD player
MCI open cdaudio

REM Then, we start it playing
MCI play cdaudio

REM pause it...
MCI pause cdaudio

REM and resume"
MCI play cdaudio

REM now we will tell it to play song number 2
MCI set cdaudio time format tmsf
MCI play cdaudio from 2:00:00:00

REM done - stop playing and close the device
MCI stop cdaudio
MCI close cdaudio

There are far too many MCI commands to document here. For more information, consult the Microsoft 
Multimedia Developer's Kit Programmer's Reference.



MOVE CHORD    <n>,<n>,...          <name>    TO            FRETBOARD
                        <n>,<n>,...          <name>    TO            BAR    <bar number>, <division>
                        <n>,<n>,...          <name>    TO            STAFF
                        <n>,<n>,...          <name>    TO            PALETTE

This command is used to place the chord specified in the destination specified. The numbers immediately
after the MOVE CHORD part of the command specify the fret positions of the strings from lowest to 
highest. The actual notes created depend on the current tuning of the instrument. If you are going to 
specify chords you should include a command to load an instrument at the beginning of your script that 
matches your chords. The value 0 is used to denote an open string.

The <name> parameter is the name of the chord.

When specifying a move to a bar, you must specify the bar number, and the division number inside the 
bar. The value 1 specifies the first division. This should also be used if there are no splits in the bar (ie. 
less than 2 divisions.)

How added to script: Movement of chords to the Song window, Staff window and Chord Palette window 
are automatically added to a script while recording. To store movement to the Instrument window, select 
the 'Chord on Fretboard' option from the Script menu. This is done this way since there is often a lot of 
experimentation done with the chord in the Instrument window before the desired result is achieved. 
Storing every chord created would be too cumbersome.

Examples:

MOVE CHORD 0,2,2,1,0,0 EMaj TO FRETBOARD 

This example, for normally tuned guitar, has the string values, from lowest to highest: open, 2nd fret, 2nd 
fret, 1st fret, open, open.

MOVE CHORD 3,5,5,4,3,3 GMaj TO BAR 1,2

This example moves a G Major chord to the first bar of the song, in the second division.

MOVE CHORD 0,2,2,1,0,0,2,2,1,0,0,2 EMaj TO STAFF

This example moves a G Major chord for a pretend 12 stringed instrument to the Staff window.



MULTIPLE CHOICE

This command is used to create a multiple choice question to ask of the user. Up to five responses can be
supplied. The correct answer can be specified by the letter of the response or a number (1 for the first 
one, 2 for the second one, etc.)

Each of the 'key words' such as "MULTIPLE CHOICE", "CHOICE", and "ANSWER" must appear at the 
start of a new line. 

How added to script: by selecting the 'Multiple Choice' entry from the Script menu while recording a script.

Examples:

MULTIPLE CHOICE 
QUESTION Is this a sample Multiple Choice Question?
CHOICE Yes, it is.
CHOICE No, it is not.
CHOICE Do you think it wants to be a multiple choice question?
CHOICE It may be, and it really doesn't matter.
CHOICE All of the above.
ANSWER 1

MULTIPLE CHOICE 
QUESTION What note is a perfect fifth above the one pictured?
CHOICE A
CHOICE Bb
CHOICE G#
ANSWER B



PAUSE <seconds>

This command pauses the script for approximately the number of seconds specified.

How added to script: by selecting the 'Pause' entry from the Script menu while recording a script.

Example:

PAUSE 20



MINIMIZE <window>
RESTORE <window> <left side (x)>, <top (y)>, <width>, <height>
MAXIMIZE <window>

Each of these commands manipulates the dimensions of the window specified. Minimize makes a window
into an icon. Maximize makes a window the full size of the screen. Maximizing only applies to the Song 
and Rhythm Editor windows.

The RESTORE command takes coordinates for the top left corner of the window, its width and its height. 
Each of these coordinates is expressed in 1/100ths of the size of the screen. For example RESTORE 
INSTRUMENT 0, 10, 25, 80 would move the instrument window to the far left of the screen, 10/100ths of 
the screens height from the top (or 1/10 of the screens height). It would make it 25/100ths of the screens 
width wide, and 80/100ths of the screens height tall.

Each of the windows is specified with a particular name as follows:

Name: Window:
INSTRUMENT Instrument
SONG Song 
RHYTHMEDIT Rhythm Editor
PALETTE Chord Palette
CRPALETTE Chord Rhythm Palette
DRPALETTE Drum Rhythm Palette
MELPALETTE Melody Palette
BPPALETTE Bass Part Palette
CONPALETTE Control Palette
TEMPOTempo
STAFF Staff

How entered into script: Any movement, resizing, minimizing or maximizing of any of the Power Chords 
windows results in one of these commands being added to a script being recorded. Note: when a script is 
started recording, the current positions of all windows is stored in the script. You may want to set up the 
windows for the opening of your script before you start recording.

Examples:

RESTORE INSTRUMENT 0, 0, 25, 64
MAXIMIZE RHYTHMEDIT
MINIMIZE CONPALETTE
RESTORE STAFF 31, 2, 15, 47

RESTORE DISPLAY <left side (x)>, <top (y)>, <width>, <height>

This is a special version of the RESTORE command. It applies to the positioning of the next DISPLAY or 
DISPLAYTIMED text window. The coordinates work as with other windows - in 1/100ths screen 
dimensions. The height value will be adjusted as needed for the amount of text displayed.

Example:

RESTORE DISPLAY 25, 10, 50, 50



PLAY SONG

This command plays the song in the song window just as if the 'Play' button had been pressed. No other 
commands in the script file are executed until the song is finished.

How added to script: by selecting the 'Play Song' entry from the Script menu while recording.

Example:

PLAY SONG



LOAD SCRIPT <script file name>

This command loads the script file named, and starts it playing.

How added to script: This command can only be added to a script by editing it.

Example:

LOAD SCRIPT C:\POWCHORD\TUTOR2.SCR



Panic Button

This menu option send an 'all notes off' command on every MIDI channel.    Then it sends a 'note off' 
command for every note on every channel.    This will release any 'stuck' notes.



Help

This menu option invokes the Windows Help facility at which you are now looking



About

This menu option shows you the 'About Power Chords' dialog box displaying version and other 
information.



Suspend MIDI

This option turns off the MIDI output and frees the MIDI output driver currently selected in the MIDI 
Configuration. This is handy for when you want to switch between two or more MIDI programs that use 
the same output driver.

Note that when you select Suspend MIDI the menu item changes to Resume MIDI. Selecting Resume 
MIDI turns MIDI output back on.



Patch Memory Left

This menu item is grayed out unless you are using an Advanced Gravis UltraSound card. It will show 
you the amount of patch memory left on the card.



Instrument
Description
Tuning and Setting the Patches Used

How To Use the Instrument
Chord Naming
Chord Request
Sliding Fingers
Transferring Chords to Other Windows
Hammer Ons



Chord Palette
What It Is: A storage area for chords.    Chords can be moved here from the Instrument or Song 

windows.    Chords can be moved from here to the Instrument, Song or Staff windows.   
When you save a Power Chords song file, the contents of all palettes are saved along 
with the song.

What Is Seen: Each chord in the Palette is represented by a window with the chord name as its title.    
In the window is a picture of the chord.

Window Buttons:

Tile Button: This re-arranges the chords in the palette in an orderly non-overlapping fashion.

Cascade Button: This re-arranges the chords in the palette in an overlapped fashion.

Sound Button: This button causes each chord in the palette to be sounded in turn.    As each chord is 
played, it is displayed in inverse colors for identification.

How To Use: To copy a chord from the palette, click on the chord picture and drag to destination.    
Then release the mouse button.    Valid destinations are the Instrument, Song, Staff, 
and Garbage windows.

To move a chord, click on the chord title and drag the chord where you want it.    
Chords can only be moved inside the Palette in this fashion.

To sound a chord, click the right mouse button over the chord picture.

To discard a chord from the palette, drag it to the Garbage Window and release the 
mouse button.

To clear the palette of all chords, select 'Palette' from the menu, and then 'Clear Chord 
Palette'.



Chord Rhythm Palette
What It Is: A storage area for chord rhythms.    Chord rhythms are created using the Rhythm 

Editor.    When you save a Power Chords song file, the contents of all palettes are 
saved along with the song.

What Is Seen: Each chord rhythm is represented by a window.    The caption bar of the window 
contains the chord rhythm title, and inside the window is a chord rhythm grid.

Window Buttons:

Tile Button: This re-arranges the chord rhythms in the palette in an orderly non-overlapping fashion.

Cascade Button: This re-arranges the chord rhythms in the palette in an overlapped fashion.

How To Use: To sound a chord rhythm, click the right mouse button on the chord rhythm graph.    
The chord rhythm will be played using whatever chord is on the Instrument.    To stop 
playing the chord rhythm before it is finished, click the right mouse button on the chord 
rhythm again.

To move a chord rhythm, click on the chord rhythm title and drag the chord rhythm 
where you want it.    Chords can only be moved inside the Palette in this fashion.

To copy a chord rhythm from the palette, click on the chord rhythm graph (not the title) 
and drag to the destination window.    Valid destinations are the Song, Rhythm Editor, 
and Garbage windows.

To  edit the title, double click on the rhythm. Note that you can't change the MIDI 
channel for the chord rhythm here (the option is grayed out). This is because the MIDI 
channel(s) for the instrument strings are set in the Tuning Options dialog box.

To discard a chord rhythm from the palette, click on the chord rhythm graph and drag 
to the Garbage window.

Note: If you want to change the instrument sounds (or patches) for the instrument part, you can do so 
by accessing the Options..., Tuning item from the main menu. See Tuning and Setting the Patches 
Used



Control Palette
What It Is: A generator and storage area for MIDI control sequences.    Control sequences are 

used to send control type MIDI data such as Patch changes and Controller changes to 
a MIDI device.    When you save a Power Chords song file, the contents of all palettes 
are saved along with the song.

What Is Seen: Each control is represented by a window with a title and a control picture in it.

Window Buttons:

New Button: Click on this button to create a new control sequence.    This invokes the New Control 
dialog box.

Tile Button: This button re-arranges the controls in the palette in an orderly non-overlapping 
fashion.

Cascade Button: This button re-arranges the controls in the palette in an overlapped fashion.

How To Use: To create a new control sequence click on the 'New' button.    This invokes the New 
Control dialog.    You can enter an unlimited stream of control commands.    Each 
command consists of either a Patch change or Control command.    These are selected 
from a group of radio buttons.    You will be prompted to enter the needed data for each 
type of control, as well as a title.    The dialog shows you one command at a a time from
the stream.    You move through the stream by pressing the 'Prev' and 'Next' buttons.    
When you have the information entered select 'OK' to save the control.    Make sure you
enter a descriptive title for the control. Note that the current position in the stream of 
commands is indicated by the Cmd: display in the upper right hand corner.

To play a control, click the right mouse button on the control.    The MIDI control bytes 
will be sent out.

To move a control rhythm, click on the control rhythm title and drag the control rhythm 
where you want it.    Controls can only be moved inside the Palette in this fashion.

To copy a control sequence from the palette, click on the control box (not the title) and 
drag to the destination window.    Valid destinations are the Song, and Garbage 
windows.

To  edit or review the title or contents of the control, double click on the control.

To discard a control sequence from the palette, click on the control box and drag to the
Garbage window.



Drum Rhythm Palette
What It Is: A storage area for drum rhythms.    Drum rhythms are created using the Rhythm Editor. 

When you save a Power Chords song file, the contents of all palettes are saved along 
with the song.

What Is Seen: Each drum rhythm is represented by a window with a title and a drum rhythm graph.

Window Buttons:

Tile Button: This button re-arranges the drum rhythms in the palette in an orderly non-overlapping 
fashion.

Cascade Button: This button re-arranges the drum rhythms in the palette in an overlapped 
fashion.

How To Use: To sound a drum rhythm, click the right mouse button on the drum rhythm graph.    The 
drum rhythm will begin to play.    To stop playing the drum rhythm before it is finished, 
click the right mouse button on the drum rhythm again.

To move a drum rhythm, click on the drum rhythm title and drag the drum rhythm where
you want it.    Drum rhythms can only be moved inside the Palette in this fashion.

To copy a drum rhythm from the palette, click on the drum rhythm graph (not title) and 
drag to destination window.    Valid destinations are the Song, Rhythm Editor, and 
Garbage windows.

To  edit the title, double click on the rhythm. Note that you can't change the MIDI 
channel for the drum rhythm here (the option is grayed out). This is because the MIDI 
channel for drum sounds are set in the Drum Sounds dialog box.

To discard a drum rhythm from the palette, click on the drum rhythm graph and drag to 
the Garbage Window.



Melody Palette
What It Is: A storage area for melodies.    Melodies are created using the Rhythm Editor.    When 

you save a Power Chords song file, the contents of all palettes are saved along with the
song.

What Is Seen: Each melody is represented by a window with a title and a melody picture in it.

Window Buttons:

Tile Button: This button re-arranges the melodies in the palette in an orderly non-overlapping 
fashion.

Cascade Button: This button re-arranges the melodies in the palette in an overlapped fashion.

How To Use: To sound a melody , click the right mouse button over the melody icon.    The melody 
will begin to play.    To stop playing a melody before it is finished, click the right mouse 
button on the melody again.

To move a melody, click on the melody title and drag the melody where you want it.    
Melodies can only be moved inside the Palette in this fashion.

To copy a melody from the palette, click on the melody icon (not title) and drag to 
destination window.    Valid destinations are the Song, Rhythm Editor, and Garbage 
windows.

To  edit the title, MIDI channel, or patch selection, double click on the rhythm.

To discard a melody from the palette, click on the melody icon and drag to the 
Garbage Window.



Bass Part Palette
What It Is: A storage area for bass parts.    Bass Parts are created using the Rhythm Editor.    

When you save a Power Chords song file, the contents of all palettes are saved along 
with the song.

What Is Seen: Each bass part is represented by a window with a title and a bass player picture in it.

Window Buttons:

Tile Button: This button re-arranges the bass parts in the palette in an orderly non-overlapping 
fashion.

Cascade Button: This button re-arranges the bass parts in the palette in an overlapped fashion.

How To Use: To sound a melody , click the right mouse button over the bass part icon.    The bass 
part will begin to play.    To stop playing a bass part before it is finished, click the right 
mouse button on the bass part again.

To move a bass part, click on the bass part title and drag the bass part where you want
it.    Bass parts can only be moved inside the Palette in this fashion.

To copy a bass part from the palette, click on the bass part icon (not title) and drag to 
destination window.    Valid destinations are the Song, Rhythm Editor, and Garbage 
windows.

To  edit the title, MIDI channel, or patch selection, double click on the rhythm.

To discard a bass part from the palette, click on the bass part icon and drag to the 
Garbage window.



Rhythm Editor
The Rhythm Editor is used to create most of the music elements in Power Chords.    Musical time is 
represented as a grid with time running left to right and different notes running top to bottom.The darker 
vertical lines in the grid indicate beats.    The beats are numbered at the bottom of the grid.    Notes are 
represented in the grid as blue squares.    The intensity of color indicates the relative loudness of the 
note (MIDI velocity).    The longer the note square, the longer the note.    

You can create and edit Chord Rhythms, Drum Rhythms, Melodies, and Bass Parts with the Rhythm 
Editor.    You can also use the Rhythm Editor to record Melodies and Bass Parts from an external MIDI 
instrument, or to import Melodies and Bass Parts from external standard MIDI files.

Chord Rhythms are a little bit different than the other music elements that the Rhythm Editor can 
create.    When editing a chord rhythm, the horizontal areas are not used to represent notes, but the 
instrument strings.    A chord rhythm can not be played by itself - it needs a chord to tell it what notes are
on the strings.    When in the Rhythm Editor, whatever is currently on the Instrument is used to play the 
chord rhythm.    This is also the approach when playing a chord rhythm from the Chord Rhythm Palette 
with the right mouse button.    However, when a chord rhythm is in the Song window, it must get the 
actual notes it plays from the chords in the bar.    If the chord changes during the bar, the notes the 
chord rhythm plays change with it.    The same chord rhythm can play many different notes depending 
on the chord put with it, because it indicates when the strings are to be played, not which notes.

Melodies and Bass Rhythms are straight forward.    The horizontal areas represent notes.    The range 
of these notes is set when you create a new rhythm, or when you import or record from a MIDI 
instrument.

Drum Rhythms are also straight forward.    The horizontal areas represent the different sounds 
available in the Drum Kit.

Control Button The control button at the top left of the rhythm editor invokes the Rhythm Editor menu. 
This menu contains a few extra entries above the usual 'Restore','Move', 'Minimize' and 'Maximize' 
items. 

Chord Rhythms:
Drum Rhythms:
Melodies:
Bass Parts:
The first four menu entries allow you to switch between the four different types of musical information 
you can edit with the rhythm editor - Chord rhythms, Drum Rhythms, Melodies, and Bass Parts.    
You can freely switch between these four without losing data.    In addition, the size of the rhythm editor 
is maintained separately for each rhythm type.    So, if you need only a small window for entering Chord 
Rhythms, but a large area for Drum Rhythms, you won't have to resize the rhythm editor window as you
switch from one type to the other.

Available for melodies and bass parts: 'Import from MIDI file'.    This menu option allows you to pull a 
single track from a type 1 standard MIDI file.    So if you have a favorite melody or bass part from 
another sequencer program, you can import it directly into Power Chords. When you select this option, 
a file name entry dialog box is presented. After you enter a MIDI file name, the MIDI file is scanned to 
see what is it. Then a list box is presented that allows you to select which track from the MIDI file to 
import.

Once a melody or bass part is imported, all information in it will go out on one channel at playback time.
The channel information originally stored in the imported part is removed. The channel is specified via 
the Edit Rhythm dialog box, invoked by double clicking on a Melody or Bass Part once it is stored in a 



palette or in the Song Window.    You can also specify a patch for the music element.    If you specify a 
patch of -1, no patch change will be sent when the part starts playing.    The channel and patch can also
be set when you do a New command from the Rhythm Editor.

Available for melodies and bass parts: 'Strip Control Bytes'. This option removes all MIDI control bytes
(ie. anything that is not a note-on or note-off) from the melody or bass part including pitch bend, patch 
change, and control change commands. This is useful after importing or recording a MIDI part that 
contains unwanted MIDI commands in it.

Play Button Plays the current rhythm once through.    As the rhythm plays, the grid 
information will be scrolled if necessary to show the current beats being played.    A black bar will appear
above the current beat.    When playing is done, you will be returned to the beat you were at when 
playback started.

Loop Button Plays the current rhythm over and over until stop button is pressed.    While the rhythm 
is looping, you can add or remove notes in the grid, change resolutions, etc.    to create your rhythm in 
an interactive way.    This is especially useful when creating drum rhythms.

Stop Button Stops the currently playing or looping rhythm.    Also stops recording.

Title Button Brings up the title edit dialog box so you can set the title for the current rhythm. 
When you export a rhythm, the current title will be used unless it is 'Untitled'.    If it is 'Untitled', you will 
be prompted to enter a title at the time of the export.

Once you give a title to a rhythm on export, a numeric value is added to create a new title in the Rhythm
Editor.    For example, suppose you export a rhythm and call it 'Verse'.    The title in the Rhythm Editor 
will change to 'Verse:1'.    Now you might make a few modifications in the Rhythm Editor to come up 
with a variation on your original rhythm.    When you export it, the new rhythm will be given the title 
'Verse:1', and the title in the Rhythm Editor will now change to 'Verse:2'.    This is very handy for creating
rhythms with different variations.

When you drag a rhythm back to the Rhythm Editor for editing, its name comes with it.    When you drag
it back to its destination, it will be given the same name, but the name in the Rhythm Editor will 
automatically get the next highest unused version number from what is in the Palette.    For example if 
you have 'Verse:1' through 'Verse:5' in the palette, and you edit 'Verse:2' and then drag it back to the 
palette, the Rhythm Editor will then have 'Verse:6'.

New Button Brings up the New Rhythm dialog box.    In it you can select the type of rhythm 
to be created, its length, note range, title, channel and patch.    When you accept the parameters, a new
rhythm is created and the previous information for that rhythm type is lost.

Note: In the New Rhythm dialog box you can set the MIDI channel only for Melodies or Bass Parts. The
MIDI channel for Chord Rhythms is set in the Tuning Options dialog box and the MIDI channel for Drum
Parts is set in the Drum Sounds dialog box, both accessed from the Options menu item.

Edit Patch Dialog: If you are using the Roland GS or General MIDI patch mapping, the Edit Patch 
button in the New Rhythm dialog box will be enabled for Melodies and Bass Parts. When you select 
this, the Patch Select dialog box will show up. From this dialog box you can select by name any of the 
Roland GS or General MIDI patches by name. To test a patch use the right mouse button.



The Edit Patch dialog has three list boxes. For General MIDI patches, only the leftmost box is used. For
Roland GS, select patches from the leftmost box first. This is the Capital Tone. Any Sub-Capital Tones
are shown in the middle list box. If you select a Sub-Capital tone, the Variant Tones will be displayed in
the rightmost list box. Also, there may be Variant tones available for the Capital Tone selection. A 
display at the bottom of the dialog box indicates which tone is currently selected.

The Edit Patch dialog is also accessed from music elements in Palettes or in the Song window by 
double clicking on them, and then selecting the Edit Patch button. When accessed in this manner the 
right mouse button clicked in the Edit Patch dialog plays the music element using the current patch 
selected. This is very handy for testing out which patch to use for a Melody or Bass Part.

Zap Button Clears all notes for the currently showing Rhythm.

Rec Button Invokes recording for Melodies and Bass Parts.    A 1 bar count in is played 
before recording begins.    Any notes played before the first beat are altered so that they start right on 
the first beat.    They stop at the same point as they did when recorded.

While you are recording, there is no indication that anything is taking place except the playing of the 
metronome beat. Once recording is done (after the length of the rhythm is passed or the Stop button is 
hit) a message box appears indicating how many events were recorded. Click OK to remove this 
message box and the newly recorded melody or bass part will be displayed in the Rhythm Editor.

If you press the Record button and you already have notes in the Rhythm Editor, you will be reminded 
that recording will overwrite the current part, and asked if this is OK. If you don't mind your part being 
overwritten with a new recording, click OK to continue. If you want to keep your current part, transfer it 
to the appropriate palette, and then record the new one.

Transfer Button    Used to copy the rhythm from the editor to a destination window.    Valid 
destinations are the appropriate Palette window, the Song window, or the Garbage window.

Resolution Scroll Bar    This scroll bar, just to the left of the play and loop buttons, allows you to 
change the resolution of the rhythm editor grid in terms of the number of divisions per quarter note.    
This is mainly used for the easy entry of various values of notes.

For example, if you want to enter quarter notes, you would use the very top resolution of one division 
per quarter note.    Then as you click on the grid, quarter notes are entered.    To enter eighth notes, click
the down arrow on the scroll bar once.    This changes the grid so that there are two divisions per 
quarter note (eighth notes).    The resolutions go down to 96 per quarter note.

Making Long Notes    You can enter notes longer than the current division by pressing the Shift key 
and then creating a new note, and dragging it to the right while the shift key and mouse button are still 
pressed.    This extends the note to the right.

All notes in a given area are displayed no matter what resolution they were created at.    You can always
remove any note visible, or change the velocity of any note visible.

Velocity Change Buttons These change all the velocity of every note in the current rhythm up or 
down by 4 for each button press.



Velocity Scale    This scale allows you to change the default velocity (loudness) of new notes 
you create in the rhythm editor.    There are eight divisions.    Lighter colored divisions are quiet, and 
darker ones are louder.    MIDI velocity values can range up to 128, so each color represents an 
increment of 16.    The velocity of an individual note can be altered by clicking on it with the right mouse 
button and dragging up or down.    As the mouse is dragged, the note will be re-triggered at the new 
velocity so you can judge where you want it to be.    As the velocity changes, the color of the note will 
change also.

Horizontal Scroll Bar    This scroll bar appears when the whole rhythm can not be displayed at once.    
It allows you to shift right or left to the beat desired.

Not Available Cursor    When you try to drag a chord or music element and that option is unavailable 
(primarily when music is playing or being recorded), the cursor changes to this symbol to indicate that 
you're not allowed to drag the element at this time. This can occur when dragging from the Rhythm 
Editor, Song Window, or any of the Palettes.



Song Window
What It Is: The Song window is the heart of songwriting and music playing in Power Chords.    The 

Song window provides a bar by bar framework in which you can place the various 
music elements that make up a song such as Chords, Chord Rhythms, Drum Rhythms,
etc.

What Is Seen: The music elements dragged to the bars of the song window are displayed.    Display of 
all the different types of music elements can be turned off in the Song Options dialog 
box, reached via the Song menu.    

Window Buttons:

Play Button    This button starts the song playing.    What is played depends on which music elements 
are selected to be played in the song options, not what is displayed.    If lead in bars are selected, the 
metronome information set in the song options is used to provide a quarter note count in.    If the 
metronome is selected, it plays throughout the song.

Songs play until they reach a bar with no music elements in it, or until they are stopped.

To start playing at a particular bar: double click on that bar in an empty area, that is, an area where 
there is no music element or chord. The song will start playing at that point. Note that music elements 
that start before the bar will not be played. Music elements that start or repeat on the bar will be played, 
as will all music elements starting or repeating after the bar.

To play any element visible in a song: click the right mouse button on the element.

To play a single bar: click the topmost area of the bar, just under the edge with the right mouse 
button.

Stop Button:    The stop button stops the song playing immediately.

Cleaver Button:    The cleaver is used for subdividing bars so that more than one chord can be put in a 
bar.    When you click it the cleaver button goes down and stays that way, and the cursor changes to a 
cleaver.    To turn cleaving off click on the cleaver button again.

To subdivide a bar, turn cleaving on.    Put the mouse cursor in the bar you wish to attack and press the 
mouse button and hold it.    A floating line will be drawn through the bar.    Bars are subdivided 
geometrically.    If you want to change chords 1/2 way through a bar, put the line where it divides the bar
into two equal pieces.    When the bar is where you want it, release the mouse button.

There are distinct positions available for cleaving - two per quarter note.    You are allowed up to 4 
different chords in a bar.Once you have divided a bar, simply drag the chords into the section where you
want them.

When you put the same chord in two adjacent sections, the division disappears.



Repeat Button:    This button invokes a repeat entry dialog box.    To make a section repeat, just enter 
the To and From bars, and the number of repeats you want.    If you enter 2 for example, that section will
be played 2 times in total.    To remove a repeat, enter the bars for the repeat and specify 0 times.    This 
clears it.

You can quickly create or edit a repeat by highlighting the bars involved and then clicking the repeat 
button. This invokes the repeat entry dialog box with the to and from bars already filled in.

Copy Button:    This button is used to copy, move, or delete a range of bars. First, click on the Copy 
Button - it changes from gray to colored. Then click and drag with the mouse to highlight the bars you 
want to access. Each highlighted bar has a blue band across its top.

To highlight more than one row of bars, drag the mouse below or above the song bars area. This will 
automatically scroll the window up or down, and highlight the bars exposed.

Once a group of bars is highlighted, release the mouse button. You can then do one of the following 
options:

To copy bars: Press and hold the Ctrl key. Click the mouse button on one of the highlighted bars. The 
cursor changes to a copy arrow. While holding the Ctrl key, drag the mouse to the first bar of the area 
you want to copy to. Release the mouse button and the bars are copied.

To move bars: Click the mouse button on one of the highlighted bars. The cursor changes to a copy 
arrow. Drag the mouse to the first bar of the area you want to move the bars to. Release the mouse 
button and the bars are moved.

To delete bars: Press the Del key on your computer keyboard to delete the highlighted bars 

OR 

Click the mouse button on one of the highlighted bars. The cursor changes to a copy arrow. Drag the 
mouse to the garbage can. Release the mouse button and the bars are deleted.

How To Use: To create a song drag music elements into the appropriate bars in the song window 
from their respective palettes.    Music elements can also come directly from the Instrument or Rhythm 
Editor.

To discard a music element, click on it with the left mouse button and drag it to the Garbage window.

Editing a Music Element's Parameters: Once a music element is in the song window, its Title, 
Channel and Patch can be edited by double clicking on it. This invokes the Edit Rhythm dialog 
box, just the same as if it was double clicked on while in a Palette. However, changes made to a music 
element are reflected in all the copies of that music element in the song. For example, if the same Bass 
Part is used in three different places in the Song, and you double click on one of them and change the 
patch used, the other two instances of that Bass Part will also have their patch changed.

Various music elements behave differently in the Song window, depending on what is around them.

Chords: will not play unless they are accompanied by a Chord Rhythm.    Chords must be specified in 
bars - they never repeat automatically.

Chord Rhythms: never sound unless there are Chords with them.    They may be longer than 1 bar.    



They will play until overridden by a later chord rhythm.    They will repeat until overridden by a later 
chord rhythm.

Drum Rhythms: may be longer than 1 bar.    They will play until overridden by a later drum rhythm.    
They will repeat until overridden by a later drum rhythm.

Melodies: may be longer than 1 bar.    They will play until overridden by a later melody.    They do not 
repeat automatically.

Bass Parts: may be longer than 1 bar.    They will play until overridden by a later bass part.    They will 
repeat until overridden by a later bass part.

Controls: are always played at the beginning of a bar.    The do not repeat and do not run longer than 1 
bar.

Tip: to enter a period of silence for one type of music element, create an empty one with no 
notes in it and drag it into place.



Staff Window
The staff window displays a normal music staff with treble and bass clefs.    When you drag a chord onto
the staff window the notes that make up the chord are displayed on the staves.

You may also drag chords out of the staff window to the Instrument, Song, Chord Palette, or Garbage 
windows.

Use the Right mouse button inside the window to sound the whole chord.    If you put the cursor on a 
particular note, that note may be sounded using the Left mouse button.    This helps you learn about the 
individual tones that make up a chord.



Tempo Window
This window is used to set the tempo for song playback.    You can set a tempo from 32 beats per 
minute to 250 beats per minute.

The tempo specified is also used when Exporting a standard MIDI file as the tempo to play the song 
back at.



The index contains a list of all Help topics available.    For information on how to use Help, press F1 or 
choose Using Help from the Help menu.



Instrument Description

The Instrument window contains this emulation of a stringed Instrument.    This is where chords are 
created for storage in the Chord Palette, and later use in Songs.    It is also a testing ground for different 
tunings and sounds, and can be set up to emulate almost any stringed instrument, in terms of the 
number of strings, frets, and tuning of the strings.
Nut Area
Fretboard
String Bending Area
Chord Strum Area
String Pluck Area
Chord Name

Related Topics:
Options menu item Instrument Options
Options menu item Tuning Options



Nut Area

This area is used to show information about the strings.    The type of information shown is selectable 
using the Instrument Options dialog box

When Normal Symbols is selected 'o's are used to denote open strings and 'x's are used for blocked 
strings.    When there is a note on the string nothing is displayed.

When Show Note Names is selected, the note name of the selected note on each string is displayed.

When Show MIDI Notes is selected, the MIDI value for the selected note on each string displayed.



Fretboard

To draw notes on the fretboard, click the left mouse button over the desired location.    If you drag after 
creating a finger, the finger positions will track with the mouse.    To erase a finger click on it with the 
mouse.    If you click and drag after erasing a finger and then contact other fingers they will be erased as
well.    The operation performed while dragging is determined by the first action done.

To mark a string open, erase its finger or click in the Nut area.    To block a string so no sound will come
from it, click on an open string in the Nut area.

.



String Bending Area

To bend a string click on it in this area and drag right or left.    This causes pitch bend information to be 
sent out on the string's MIDI channel.    Note that other notes currently sounding on this will be affected 
as well.    When you release the mouse button, the pitch bend is reset.



Chord Strum Area

In the Chord Strum Area the cursor appears as a pick.    Clicking the left mouse button in this area 
causes the chord on the fretboard to sound.    Notes sounded will be played until the mouse button is 
released.    Note that using the right mouse button in most areas of the Instrument window has the same
effect.



String Pluck Area

When the mouse cursor is in the String Pluck area it changes into the shape of a guitar pick.    To pluck 
a string, press down the left mouse button and drag the point of the pick over the string to be sounded.   
Notes sounded will be played until the mouse button is released. If you hold the mouse button down, 
you can strum back and forth repeatedly over the strings, sounding each string as it is passed.



Chord Name

This area will have the current chord name in it when auto chord naming is on or when a chord name 
has been requested using the Name button in the instrument window.    When a chord is dragged to the 
Instrument Window, the name of the chord is displayed here as well.



How To Use The Instrument
Creating Chords:

1.    Click left mouse button or drag on Fretboard area to position fingers or
2.    Click on Chord Request button to create a specific chord.

Playing Chords:

1.    Click right mouse button in the Instrument window at any time to sound the current chord.
2.    Click on the Chord Strum Area to sound the chord.
3.    Click on the String Pluck Area to sound notes individually or to strum the chord.
4.    To bend notes, click on the desired string in the String Bending Area (the blue rectangle) 

and drag to the left or right.



Chord Naming
When you press the Name button in the Instrument Window, a dialog box will pop up with various 
alternative names for the chord currently on the fretboard.    You can select one of the names provided 
or type in your own in the top edit box if non meets your approval.    When you OK a chord name, it will 
be displayed under the fretboard.    This is the name that will be given the chord should you drag it to 
the Chord Palette or other destination.

Related Topic:
Instrument Options dialog item Auto Chord Naming



Chord Request
The Chord Request dialog is invoked by pressing the Rqst button on the Instrument Window.    This 
brings up a dialog box that allows you to quickly and easily create, audition and store chords from the 
simple to the very complex.    It is a great tool to use if you are entering a song for which you have the 
chords already to get all the chords you need quickly into the chord palette.

The Chord Request dialog stays active and lets you access all other parts of Power Chords while it is 
still available.    To remove it, click the menu request box on the upper left hand corner of the Chord 
Request dialog to bring down the menu. Select Close Alt+F4 to close the dialog box.

The controls in the Chord Request dialog box are mainly buttons, grouped into different types 
surrounded by a box with a title.    Where radio buttons (round) are used, you must select one and only 
one from each group.    Where check boxes are used (square) you may make a selection if desired.    
However, the Domin group only allows a maximum of 1 selection.    The Add group allows you to make 
as few or as many selections as you wish.

Input Panel Groups:

Root: Select the desired chord letter name root (eg: C, C#, D).

Triad: Select the desired chord triad base type (eg: Major, Minor).

Domin: If a dominant chord is desired select the appropriate entry (eg: 7)

Add: If any additional chord elements are required, select appropriate entries (eg: b11, b9).

Fret Range: Defines the number of consecutive frets on the fretboard (inclusive) which the chord 
can occupy.    Making this value smaller will yield chords that are playable by human 
hands.    Making this value larger gives chords with more variation across a wider range
of the instrument.    These chords may require the assistance of a friend, pet, or non-
humanoid to actually play on a real instrument.

Strict: Turns on strict inversion creation.    When creating a new chord, if Strict is turned on, 
each chord created is guaranteed to have the first notes of the chord represented.    
The notes affected are the notes that make up the chord, from the tonic or first note, on 
up .

The number of notes guaranteed to be represented is specified by the value entered for
the number of strict notes.    

Here is an example.    Lets say that we have specified a C Major chord with added b7 
and b9.    The notes of the chord are: 1, 3, 5, b7 and b9, or C, E, G, Bb, and Db.If Strict 
Notes is set to 4, and Strict is turned on each inversion generated is guaranteed to 
have the first 4 notes (C, E, G, and Bb) represented in every chord inversion created.    

When Strict is turned off, various notes from the chord in different inversions may be 
missing.    If the strict guideline causes the inability to create a chord, you will be 
informed via a message box.

Strict Notes: Defines the number of notes which a chord inversion must contain.    See Strict above.

Auto Load: Causes any changes in the selection of chord elements to automatically create the new
chord on the Instrument fretboard.    This is equivalent to pressing OK/Next after every 
change is made to the selection of chord elements.



OK/Next: This button causes a new chord inversion to be created on the Instrument fretboard.    It
can be pressed over and over to get various inversions of the chord desired.

To Palette: This button causes the chord currently on the instrument to be transferred directly to 
the chord palette.

The right mouse button can be used to sound the chord on the instrument fretboard at any time by 
clicking it inside the Chord Request dialog.    In conjunction with Auto-load this makes it very handy to 
quickly create and try out all sorts of different chords.



Sliding Fingers

Finger Movement Buttons: In the instrument window is this group of four finger movement buttons.

Clicking on the left arrow button moves the chord displayed on the fretboard one string to the left.    As 
the chord moves off to the left, the remaining string(s) to the right of the chord are blocked.    Notes 
moved beyond the leftmost string are lost.

Clicking on the right arrow button moves the chord displayed on the fretboard one string to the right.    
As the chord moves off to the right, the remaining string(s) to the left of the chord are blocked.    Notes 
moved beyond the rightmost string are lost.

Clicking on the up arrow button moves the chord displayed on the fretboard one fret upwards.    As 
each note moves above the top fret, the string it was on becomes open.    If another upwards move 
occurs the open string becomes blocked and the note previously on the string is lost.

Clicking on the down arrow button moves the chord displayed on the fretboard one fret downwards.    
As each note moves down off the bottom fret, the string it was on becomes blocked and the note is lost.



Transferring Chords to Other Windows

Chord Export Button: This button is used to transfer chords from the fretboard to the Staff, Palette, 
Song, or Garbage windows.    Click on the Transfer icon with the Left mouse button and hold it.    Notice 
that the cursor changes to a small chord.    Drag the chord to the desired location in the Staff, Chord 
Palette, or Song windows and release the button to copy the chord.    If the chord is dragged to the 
Garbage window, the fretboard will be cleared of fingers.    You can also accomplish this by double 
clicking the left mouse button on the fretboard.



Hammer Ons

Hammeron Button:    When you click on this button the cursor changes to a grace note, and the button 
remains pressed until you click on it again.    You can now enter hammer on notes on the fretboard.    A 
hammer on is a note sounded some time after the normal note on the string is played.    This is akin to 
holding a finger on a string on a guitar, plucking the string, and then quickly bringing another finger 
down on a fret higher than the one where the first finger is.    This causes the string to quickly play the 
first note, and then change to the second (hammered on) note.

To return to entering normal fingered notes, click on the hammer button again.    This will 'un-press' it , 
and change the cursor back to normal.

Hammer ons are shown as grey filled circles.    The length of time between the initial string sound and 
the hammer on note is set in the Instrument Options dialog.

On the fretboard, when a hammer on and a regular finger are on the same spot, the hammer on is 
shown.    A hammer on placed on an open string (ie: in the nut) will be active but will be overwritten by 
any symbols in the nut - either an open or blocked string.



Garbage Window
The Garbage window can be used to discard all sorts of objects by dragging them to it and releasing 
the mouse button.    Objects that can be deleted are chords, chord rhythms, drum rhythms, melodies, 
bass parts and controls.

If you drag a chord to the Garbage window from the Instrument or Staff windows, the chord in the 
window will be cleared.

If you drag any type of rhythm to the Garbage window from the Rhythm Editor, that rhythm will be 
cleared from the Rhythm Editor.    This is the same as the Zap button in the rhythm editor.



Script Facility Description
The Power Chords script facility gives the ability to design interactive tutorials, lessons or presentations 
using Power Chords.    A script file contains a list of commands to Power Chords to do various actions 
such as display a particular chord, display some text for the user to read, wait for a number of seconds 
while the user tries out something, etc.

A script file is prepared in advance using the Power Chords script record facility.    Some actions are 
performed directly in Power Chords, and are recorded to the script file automatically.    Other actions are
selected from the script menu.    Usually these require you to fill in a dialog box of some sort depending 
on the action selected.    When the dialog is complete, the action is stored in the script.

Once a script file is complete, it can be loaded into Power Chords and 'Played'.    Script files can be 
copied freely and transferred between Power Chords users.




